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Overview 
WhereScape RED provides an environment to facilitate the rapid production of prototype data warehouse analysis 
areas. It also provides the functionality to move that prototype into a production environment and support the day-
to-day running of a data warehouse. 

The Installation and Administration Guide provides the information needed to: 

• Install the WhereScape RED software. 

• Validate the various software components required by WhereScape RED. 

• Install the WhereScape RED metadata. 

• Install a Scheduler. 

• Optionally install third-party data warehouse applications. 

Note: 

The software described in this manual is furnished under a license agreement and may be used only in 
accordance with the terms of the agreement. 

 

WhereScape Forum 

A web forum is available at www.wherescape.com. This forum contains information on the latest version, and bug 
reports that may be relevant for installation. In addition, the WhereScape Blog is available at 
www.wherescape.com which may provide additional information. 

  

How to use this Manual 

WhereScape RED is designed to build data warehouse analysis areas within a database environment. The 
installation and configuration process are very rarely a simple task as it involves several layered products external 
to WhereScape RED. For the more complex cases, several hours or days should be set aside to complete this 
task.  

Therefore, it is important that the reader begins the installation process with the correct expectations. Highlighted 
below are the major steps in the installation and setup of WhereScape RED. In many environments some of these 
steps will have been completed independently of the installation process or may need to be completed by a third 
party. 

Note: 

This document does not cover the creation and configuration of the database required to run the data warehouse. 
It does not cover the procedures required to create and maintain database users; nor does it cover the installation 
of the database client software. Refer to the database vendor manuals for assistance. 

 

The Installation and Configuration chapters provide a logical outline for the installation and setup of 
WhereScape RED for the following databases: 

• For SQL Server, refer to SQL Server Installation and Configuration for details. 

• For Teradata, refer to Teradata Installation and Configuration for details. 

• For Oracle, refer to Oracle Installation and Configuration for details. 

The rest of the manual deals with the following topics: 

• Tutorial Data for creating and validating the tutorial data.  

• Applications for loading the data warehouse applications.  

• Upgrading for upgrading WhereScape RED.  

• Unix Connection for checking the Unix connection.  

• Test ODBC Source for testing an ODBC source.  
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• Validate Repository for validating a meta repository.  

• Maintain Scheduler for maintaining the Windows scheduler.  

• Languages for creating and loading language files.  



WhereScape® RED Installation Manual 

  

© Copyright, WhereScape, Inc. All rights reserved. - 7 - 

Installing WhereScape RED 
Complete the following procedure to install the WhereScape RED software: 

Notes: 

Before you begin the install process:  

• Stop any WhereScape RED schedulers running on the computer. 

• Close any other applications that are running. 

• Ensure that you have installed the following Microsoft software packages: 

Package  File Name 
File Size 
(KB) 

Visual C++ Redistributable for Visual 
Studio 2019 (x64)  

vc_redist.x64.exe  14,708 

Visual C++ Redistributable for Visual 
Studio 2019 (x86)  

vc_redist.x86.exe  14,028 

.NET Framework 4.6.1  NDP461-KB3102436-x86-x64-AllOS-ENU.exe  66,095 

.NET Framework 4.6.1 (web installer) NDP461-KB3102438.exe 1,391 
 

 

1. Double-click the RED_xxxxx.exe file (For example: the downloaded file for version 6.8.4.0, would be 
RED_68400.exe). 
The WhereScape RED Setup Wizard window is displayed.  
 

 

2. Click Next to continue with the installation. 
 

Note: 
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Note: 

The installer checks for certain prerequisites that are needed to run some components of RED. If any of the 
prerequisites are missing, clicking Next takes you to the list of required prerequisites and you need to install them. 
To skip this step and jump directly to the installation of RED, click Finish. 

 

The WhereScape RED Setup End-User License Agreement window is displayed. Read the license 
terms.  

 

3. Select the I accept the terms in the License Agreement option and click Next to continue. 

Note: 

 If you do not accept the license agreement, you cannot continue with the installation.  

 

4. The Select Installation Folder window is displayed, showing the directory where the WhereScape RED 
software will be installed. 
To change the directory, click Browse... to navigate to the required Installation Folder and then click Next 
to continue.  
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5. The Ready to Install window is displayed, giving you the opportunity to go back and change any of the 
information you have entered so far. 

Click Install to install the WhereScape RED software.  

 

6. The Installing WhereScape RED window is displayed, showing you the progress of the installation. 
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7. A window is displayed after completing the installation. Click Finish to exit and Launch the Setup 
Administrator. 

 

Note: 

 If a scheduler was running or a program was open (when doing an upgrade), a prompt displays advising you that 
a reboot is required to finish the installation.  



WhereScape® RED Installation Manual 

  

© Copyright, WhereScape, Inc. All rights reserved. - 11 - 

 

Installing WhereScape RED from the Command Line 

It is possible to install WhereScape RED from the command line and specify a custom installation directory, using 
the APPDIR parameter by running a batch file. 

This process can be used for all metadata database types where the exe file is configured to copy the APPDIR 
property into all other relevant properties. 

Note: 

Command Line installations will only work if the relevant version has not yet been previously installed. If the same 
version has already been installed, it must always be removed first. 

 

Example 

The following is an example script that loads RED with full verbose logging: 

@echo off 

cd c:\users\user\downloads\ 

"RED_68500.exe" APPDIR="c:\WhereScape68500\" ALLUSERS=1 RebootYesNo="No" Reboot="Suppress" 

/qn+ /L*vx "c:\WhereScape\log.txt" 

exit 

Please refer to Caphyon's Advanced Installer documentation for more details about command-line options.  

To install versions of WhereScape RED older than 6.8.3.4 using the command line, please use the following script 
instead: 

@echo off 

cd c:\users\user\downloads\ 

msiexec /i "RED_68300.msi" APPDIR="C:\WhereScape68500\" ALLUSERS=1 RebootYesNo="No" 

Reboot="Suppress" /qn+ /L*vx "c:\WhereScape\log.txt" 

exit 

Please refer to Microsoft Documentation for more details about Msiexec command-line options.  

  

http://www.advancedinstaller.com/user-guide/msiexec.html
https://msdn.microsoft.com/en-us/library/windows/desktop/aa367988(v=vs.85).aspx
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Adding Your License 

Tip: 

WhereScape RED requires a valid licensee and license key. This information and the key are normally supplied in 
a separate email.  

To add your license: 

1. In WhereScape's Setup Administrator, click the Computer Setup tab and then click WhereScape RED 
License. 

 

The Welcome to WhereScape RED License screen is displayed. 
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This screen enables you to enter your license information. 

Once validated, the license information is stored in the registry and validated by the WhereScape RED 
program on start up. 

2. Enter the required information in the license fields and then click OK. 

 
The example below shows the entry of an evaluation license and key. 
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The license type window is displayed: 
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3. Click ACCEPT to confirm the type of license. 

Note: 

If the key fails to validate contact support@wherescape.com. 
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Checking your Windows Version 
WhereScape RED is supported on Windows 10 to Windows 11, UNIX or Linux environment with a screen size set 
to at least 1024x768. This step simply validates that the above requirements have been met. 

The WhereScape RED Scheduler is supported on Windows Server 2012 to Windows Server 2022, UNIX or Linux.  
WhereScape RED will not run under Windows 95, 98 or NT.  

Note:  

If the minimum screen size of 1024x768 is used, then the standard font size must also be used. 

 

To check your Windows version: 

1. In WhereScape's Setup Administrator, click the Computer Setup tab in the left pane and then click the 
Check Windows Version icon. 

 

Windows Setup details are displayed in the right pane as shown in the following screen: 
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Checking ODBC Drivers 
SQL Server ODBC drivers are shipped with Windows. This step is usually a validation of the pre-installed drivers. 

WhereScape RED connects to the data warehouse database using ODBC. This step checks that ODBC drivers 
are present and up to date.  

To check ODBC Drivers: 

1. In WhereScape's Setup Administrator, click the Computer Setup tab in the left pane and then click the 
Check ODBC Drivers icon. 

 

A list of ODBC drivers is displayed, provided the computer user has enough privileges to access the 
registry: 
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Creating an ODBC Connection 
To create an ODBC Connection: 

1. In WhereScape's Setup Administrator, click the Computer Setup tab and then click Validate/Add ODBC 
Source. 

 

2. An entry needs to exist in the ODBC tables for the data warehouse database. This step lists all entries 
found that use an ODBC driver. If no entry exists for the data warehouse database, then you need to add 
one. 

o Right-click anywhere in the right pane to bring up the Launch ODBC Data Source Administrator 
menu option. 
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3. Click the System DSN tab to view the system wide ODBC entries. 
 

 

o Click the Add... button to add a new entry.  

Note: 

ODBC connections must be either User DSN or System DSN. File DSN connections are not 
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Note: 

supported. 

 

4. From the Create a New Data Source screen, select the relevant driver and then click Finish. 

 

  

The ODBC Text Setup dialog is displayed: 

 

5. Enter the relevant details and click the OK button to create a new ODBC data source. 
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Advanced Connect 
The Advanced Connect feature provides secure user-based authentication mechanisms for your metadata, 
sources, and target connection in RED. This feature combines session based authentication and complete control 
over ODBC conection strings. 

When a Scheduler uses Advanced Connect it allows you to override the connection strings stored in the metadata 
as the Scheduler’s in-memory Profile initialization will favor the Profile file attributes over the metadata for stored 
connection strings and DSN names. This allows for headless connections on the Scheduler while still allowing 
interactive connections from the RED UI. 

Note 

Currently, this feature is only available for SQL Server metadata repositories. 

 

Before you begin 

Prior to setting up a RED Windows Scheduler using Advanced Connect it must first be enabled in RED, please 
follow the RED User Guide on Enabling Advanced Connect before continuing with the following configuration. 

You need a Profile file that includes any connections and their encrypted credentials (if required). An Advanced 
Connect Profile can be created from RED and should be created by the same Windows user the Scheduler 
service runs under so that passwords can be decrypted. 

Installing the Scheduler 

RED Setup Administrator as Admin and click Install Scheduler toolbar item to open the scheduler definition 
dialog. Make sure to change the Service logged in under User to the same Windows User that created the 
Profile file from RED. 

Once you select a SQL Server DSN in the ODBC Connection drop-down menu a new Advanced Connect control 
becomes visible, check the box, and select the Profile you created earlier. 

 

Note 

Depending on the user actually installing the scheduler and the contents of your Profile the initial connection check 
in this dialog may fail, you can usually proceed anyway as the Service logged in under User should be able to 
connect during the service startup if the Profile file was created with the same user. 
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If you open the Scheduler log file after creating the scheduler you should see a successful connection like this 
example: 

 

Modifying an existing Scheduler to use Advanced Connect 

If you already have a Scheduler and want to convert it to use Advanced Connect then run Setup Administrator as 
Admin on the machine running the Scheduler service and right click on a Scheduler and select Configure. 
Selecting a Profile file in this screen (and clicking OK) will transfer it to the correct location and naming convention 
for the Scheduler. When you next restart your Scheduler it will connect using Advanced Connect and initialize an 
in-memory Profile containing the connection attributes for each Advanced Connection in the metadata. 

Scheduler Profile Initialization 

When the Scheduler service starts and there is a matching profile file in the install directory for the Scheduler then 
the Scheduler will use Advanced Connect to connect to the metadata using the credentials and connection string 
in the Profile file. 

Example of the install directory for a Scheduler using Advanced Connect. 

 

After the initial metadata connection is made the Scheduler will then initialize an in-memory Profile by combining 
the credentials and connection strings in the Profile file with any other connections found in the metadata which 
were not included in the profile file. The Scheduler service will use the Profile file's credentials and connection 
strings if provided; otherwise, fallback to the RED metadata. 

Updating a running scheduler's Profile 

From time to time you need to add a new connection to RED that uses Advanced Connect, or to update a 
connection's credentials, these changes will not be included in any Scheduler's in-memory Profile unless a refresh 
is actioned for each scheduler. 

To refresh a Scheduler’s Profile you must perform the following steps: 

1. Update the Profile File on the Scheduler machine 
2. Then perform either of the following: 

1. ‘Poll for Status and Refresh Profile’ from RED UI 
2. Restart the scheduler service 
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Updating the Profile File 

When adding or modifying Advanced Connect connections the actual Profile file need to be recreated from RED 
by the Windows user that the Scheduler service is running under (select to include encrypted passwords when 
saving the Profile from RED). Then the file will need to be transferred to the Scheduler install directory to overwrite 
the existing profile file for the Scheduler. The profile file must have the same file name as the Scheduler .ini file but 
with the .profile extension. 

The file can be transferred manually as described above or you can run Setup Administrator as Admin on the 
machine running the Scheduler Service and right click on a Scheduler and select Configure. Selecting a Profile file 
in this screen will transfer it to the correct location and naming convention for the Scheduler overwriting the 
existing Profile. 

 

Note 

After updating a Profile file for a Scheduler the service will either need restarting or the ‘Poll for Status and Refresh 
Profile’ called from RED for the changes to be applied. 

 

Poll for Status and Refresh Profile 

Use the ‘Poll for Status and Refresh Profile’ context option on each Scheduler from the Scheduler tab of RED, 
after listing the schedulers from the menu item Scheduler>Scheduler Status 

 

Note 

Currently the only way for a Scheduler to pick up new Advanced Connect connections via this method is to first 
transfer a new Profile file containing the new connections to the Scheduler install location. See Updating the 
profile File for details. 
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Restart the Scheduler Service 

Note 

Only use this method if you are sure the Scheduler is in an idle state otherwise running tasks may be left in an 
unknown state. 

 

When the Scheduler service is restarted this re-runs the in-memory Profile initialization process. On the 
machine running the scheduler you want to refresh, run WhereScape Setup Administrator as Admin and restart 
the scheduler. Note this same process can be achieved through Windows tool Services.msc by finding and 
restarting the service. 

Tips for Using OAuth or similar authentication methods 

For some authentication methods you may need to use a script (or web browser) to login to a data source and 
generate an access token to use in your connection string. The access token could then be added in the Profile 
file as the password for a connection. If you have expiring tokens then you will need to create a script to refresh 
your tokens and restart your scheduler service to pick up the new tokens. 

This would involve the following general steps to be implemented in a script: 

1. Log in to a server and get a new token (this should be a non-interactive process for the Scheduler). 
2. Encrypt the token with Windows DPAPI ensuring the script is running as the same Windows User as the 

scheduler service. 
3. Create a base64 string from the encrypted token 
4. Modify the Scheduler Profile file (which is in .JSON format) replacing the password on the affected 

connection with the base64 string. 
5. Restart the Scheduler service OR select ‘Poll for Status and Refresh Profile’ from RED for the Scheduler. 

Example PowerShell script to create an encrypted base-64 string using Windows DPAPI: 

Add-Type -AssemblyName System.Security 
  
$myPass = "myp@ssw0rd!" 
  
# Convert the pwd string to a byte array. 
$bytes = [System.Text.Encoding]::Unicode.GetBytes($myPass) 
  
# Encrypt the byte array. 
$encryptedBytes = [System.Security.Cryptography.ProtectedData]::Protect( 
        $bytes,  
        $null,  
        [System.Security.Cryptography.DataProtectionScope]::CurrentUser) 
  
# This is the equivalent form stored in the Profile files for RED 
$encryptedProfilePassword=[System.Convert]::ToBase64String($encryptedBytes) 
  
Write-Output $encryptedProfilePassword 

 

 

If for some reason you need to decrypt the profile file passwords in a script the below method shows how to do 
this. Note that only the same Windows User that encrypted the password in the first place will be able to decrypt it. 

Example PowerShell script to decrypt Windows DPAPI encrypted base64 string: 

Add-Type -AssemblyName System.Security 
  
# set this to an encrypted string taken from the Profile file 
$encryptedProfilePassword=”<YOUR ENCRYPTED STRING>” 
  
# first convert the extracted RED Profile string FromBase64String to Byte array 
$encryptedBytes = [System.Convert]::FromBase64String($encryptedProfilePassword) 
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Write-Host "Encrypted Bytes" -ForegroundColor Cyan 
Write-Host ([string] $encryptedBytes) -ForegroundColor DarkGreen 
  
# Unencrypt the data. 
$bytes = [System.Security.Cryptography.ProtectedData]::Unprotect( 
        $encryptedBytes,  
        $null,  
        [System.Security.Cryptography.DataProtectionScope]::CurrentUser) 
  
$plainTextPwd = [System.Text.Encoding]::Unicode.GetString($bytes) 
  
Write-Host "Decrypted Data" -ForegroundColor Cyan 
Write-Host $plainTextPwd -ForegroundColor Red 
  

 

 

Example Profile file 

The Profile file is a .JSON file which makes it easy to programmatically update any connection attributes it 
contains. 

Note 

The following example has had passwords truncated for display purposes. 

 

{ 
 "connections": [{ 
   "connectionName": "Tutorial (OLTP)", 
   "connectionString": "dsn=$DSN$;uid=$USER$;pwd=$PASSWORD$;database=WslTutorial_DataSeq;", 
   "password": "AQAAANCMnd8BFdERjHoAwE/Cl+sBAAAAK9Z1yRvrzEOIvwCfKZ96UAAAAAACAAAAAAAQZgAA", 
   "userId": "red1" 
  }, { 
   "connectionName": "SQL_Target", 
   "connectionString": "dsn=$DSN$;uid=$USER$;pwd=$PASSWORD$;database=sql15_9010_pg;", 
   "password": "AQAAANCMnd8BFdERjHoAwE/Cl+sBAAAAK9Z1yRvrzEOIvwCfKZ96UAAAAAACAAAAAAAQZgAA", 
   "userId": "red1" 
  }, { 
   "connectionName": "PostgreSQL_Target", 
   "connectionString": "dsn=$DSN$;uid=$USER$;pwd=$PASSWORD$;database=pg15_9010;", 
   "password": "AQAAANCMnd8BFdERjHoAwE/Cl+sBAAAAK9Z1yRvrzEOIvwCfKZ96UAAAAAACAAAAAAAQZgAA", 
   "userId": "reduser_user" 
  }, { 
   "connectionName": "WslTutorial_DataSeq", 
   "connectionString": "dsn=$DSN$;uid=$USER$;pwd=$PASSWORD$;", 
   "password": "AQAAANCMnd8BFdERjHoAwE/Cl+sBAAAAK9Z1yRvrzEOIvwCfKZ96UAAAAAACAAAAAAAQZgAA", 
   "userId": "red1" 
  } 
 ], 
 "redConnectionMethod": "Advanced Connect", 
 "redConnectionString": "dsn=$DSN$;uid=$USER$;pwd=$PASSWORD$;database=sql15_9010_pg;", 
 "redDatabase": "sql15_9010_pg", 
 "redDsn": "sql15", 
 "redDsnArchitecture": "64", 
 "redServer": "", 
 "redServerPort": "", 
 "redUserId": "red1", 
 "redUserPwd": "AQAAANCMnd8BFdERjHoAwE/Cl+sBAAAAK9Z1yRvrzEOIvwCfKZ96UAAAAAACAAAAAAAQZgAA" 
} 
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SQL Server Installation and Configuration 

Introduction 

The steps provided here are an indication of the normal process required to install and configure WhereScape 
RED. 

In some environments additional processes will be required. 

1. Install the WhereScape RED software onto your PC. Refer to Installing RED for SQL Server for details. 
2. Add your license key. Refer to Adding your License for details. 
3. Check your Windows version. Refer to Checking your Windows Version for details. 
4. Check your ODBC Drivers. Refer to Checking your ODBC Drivers for details. 
5. Designate a database that is to be used as the data warehouse database. Refer to Creating a SQL Server 

Database for details. 
6. Add the definition of an ODBC data source to connect to the data warehouse database. Refer to 

Configuring a SQL Server Metadata Connection (DSN) for details. 
7. Create the WhereScape metadata repository. Refer to Creating a Metadata Repository for SQL Server 

for details. 
8. Install a Windows Scheduler. Refer to Installing a Windows Scheduler for SQL Server for details. 
9. If required, load the WhereScape tutorial tables into a separate database. It is highly recommended that the 

tutorials be undertaken. Refer to Creating Tutorial Data for details. 

Note: 

A Quick Start option is available for SQL Server. This option performs all the required tasks (except the entry of a 
license key) when provided with a valid database server 

 

Problem Solving 

If any problems happen in your install that cannot be resolved, proceed as follows when running WhereScape's 
Setup Administrator utility: 

1. Create a log file by selecting Tools > Start Logging from the menu bar. Enter a file name. 
2. Step through at least: 

o Computer Setup > Check Windows version. 
o Computer Setup > Check ODBC drivers. 
o Computer Setup > Validate/Add ODBC Source. 
o  Metadata Repository > Validate meta repository. 

3. Select Tools > Stop Logging to close off the log. 
4. Edit the log and remove any passwords that appear. 
5. Send your log file to support@wherescape.com. 

Installing RED for SQL Server 

Installation Prerequisites 

WhereScape RED requires certain client and server components. 

Client Prerequisites 

• Windows 10 and Windows 11. 

• 4GB RAM minimum 

• 2GB available disk space. 
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• ODBC Version 3.0 (normally shipped as part of the Operating System). 

• For building a data warehouse, the appropriate Microsoft ODBC driver for SQL Server is required. 

Server Prerequisites 

• RED requieres SQL Server versions beginning from 2012 to SQL Server 2022. 

• To use the WhereScape RED Scheduler, a UNIX, Linux or Windows based server is also required (this 
may be the database server). WhereScape RED only supports sh and ksh under UNIX and bash under 
Linux. 

Installation of WhereScape RED 

To install WhereScape RED, refer to Installing WhereScape RED for details. 

  

SQL Server Database and Login Setup 

SQL Server Database 

Create a SQL Server database to be used as the RED metadata repository and data warehouse. 

To use object placement across multiple schemas in RED, create the required schemas in the SQL database. 

Note 

The database name used for the RED repository must follow SQL Server rules for "Regular Identifiers". For 
example, the database name should not contain any spaces.  
Please refer to SQL Server documentation for more details on rules for regular identifiers. 

 

SQL Server Login Setup 

Create an SQL Server login that will be used to set up the RED metadata repository and for access by the RED 
scheduler service. The minimum SQL Server permissions are as follows: 

 Server Level Permissions 

• bulkadmin - this role is required if you want to load files or use Native ODBC loads. 

Permissions to kill a process when killing jobs in the scheduler 

• VIEW SERVER STATE 

• ALTER ANY CONNECTION 

SQL Server 2012 roles 

For SQL Server 2012 and later only, users can create server roles and grant them to the RED scheduler and RED 
users.  

Database Permissions 

Database roles (on the database with the RED metadata in it) 

• db_datareader 

• db_datawriter 

• db_ddladmin 

Database grants (on the database with the RED metadata in it) 

• SELECT 



WhereScape® RED Installation Manual 

  

© Copyright, WhereScape, Inc. All rights reserved. - 30 - 

• INSERT 

• UPDATE 

• DELETE 

• EXECUTE  

Note 

When creating a new repository or validating the metadata in an existing repository, the SQL Server login used 
must have SYSADMIN or the ALTER TRACE permission. 
This is because almost all the WhereScape procedures have a catch all with log file option exception handler. This 
ensures that if the scheduler cannot log errors to the database, it can log errors to SQL Server logs and 
Application logs. 

 

The SQL Server login for RED must have a default schema of dbo. 

Configuring a SQL Server Metadata Connection (DSN) 

To begin adding an ODBC Source from WhereScape's Setup Administrator, refer to Creating an ODBC 
Connection for details. 

1. In ODBC Data Source Administrator, click the System DSN tab to view the system wide ODBC entries.  

o Click the Add... to add a new entry. 

 

2. Select an SQL Server driver from the driver list.  
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3. Enter a Name for the ODBC Source and select or enter the Server.  

o Click Next. 

 

4. Another pop-up appears with authentication details.  

o Change as required or leave as shown if you are unsure. 

o Click Next. 
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5. The next pop-up provides the opportunity to select a database. The following example shows the selection 
of the Northwind database.  

o Select a database from the drop-down-list and click Next. 

 

6. The last pop-up enables setting of other features if desired.   

o Ensure the regional settings check-box is not used. If this is used, then date and number formats 
will be in regional standards rather than native form.  

o Click Finish. 
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7. Test the data source using the 'Test Data Source...' button, otherwise just click OK. 

 

Tip: 

If multiple PCs will access the data warehouse, they must all use the same data source name as entered here. 
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Creating a Metadata Repository for SQL Server 

1. In WhereScape's Setup Administrator, click the Metadata Repository tab and then click Create 
Metadata Repository. 

 

2. This option creates the WhereScape meta tables, sequences and procedures in the specified schema. It 
checks to ensure that the schema, database or user does not contain an existing metadata repository 
before starting the metadata install. 

o Click Create Metadata Repository. 

o Enter the ODBC Connect, User Name and Password and then click OK. 

 

3. When creating an SQL Server metadata repository, an additional screen is displayed requesting Filegroup 
information.  

o Select the required Filegroups and then click OK.  

o If Filegroups are not being used, leave the Filegroups fields blank and then click OK.  
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Notes: 

• The metadata repository and data warehouse tables must both be created under the dbo schema when 
using SQL Server as the data warehouse server.  

• Ensure that the user creating the meta repository has the required privileges to create objects in dbo.   

 

SQL Server Quick Start 

The quick start component of WhereScape's Setup Administrator attempts to do a rapid install of WhereScape 
RED onto a SQL Server database server.  

It creates two databases on this server and then installs the RED software and the tutorial; finally invoking 
WhereScape RED and the on-line tutorial help. 

1. On the Quick Start tab, click Auto install Metadata to start. 

 

2. The following prompt is displayed.  

o Click Yes to proceed with the creation of the databases.  
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3. You are first asked for the SQL Server instance in which to load the metadata repository and tutorial.  
The following window is presented. 

 

RED will attempt to locate all SQL Server servers available and list them in the drop-down. This process can fail 
for a number of reasons in which case the Instance name will need to be ascertained and entered.  

Leave the Username and Password blank, if using a trusted connection and no password is required. Click OK 
when complete. 

Once the install has completed, RED will allow you to logon to the newly created data warehouse. 

  

SQL Server Quick Application 

The quick application option for SQL Server attempts to create a Data Warehouse database, populate that 
database with the WhereScape metadata, load an application, install a scheduler and optionally run a batch job. 

It provides a means of quickly installing a RED application and getting the contents of the tables loaded and 
populated. 

1. On the Quick Start tab, click Auto Install Metadata and Application to start. 
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2. The following window is displayed.  

 

o Click Yes to proceed. 

3. The following window is displayed.  
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o Once all the values have been entered, click OK to proceed with the creation of the databases and 
the loading of the application. 

The quick application can also be initiated from the command line or from a Windows batch file.   

Windows Command Line Invocation 

The syntax for calling from the command line is as follows: 

adm.exe -QA [-SWITCH "switch value"] 

The switches that can be applied supply information to the Setup Administrator utility. When all switches are 
provided, the application install occurs automatically. Where some switches are left out a partially completed, a 
window appears. The missing information can be provided and the install then proceeds.  
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Note: 

Where a parameter for a switch contains spaces, the parameter must be enclosed in double quotes. 

 

The switches are: 

Switch Parameter to be supplied 

-QA  Indicates that this is a "Quick Application". No parameter is required. 

-SS The SQL Server instance name where the Data Warehouse database will reside. 

-SL  The administrator user name for the SQL Server instance defined with the -SS switch. If 
this switch is not provided a Trusted connection is assumed. 

-SP The administrator password for the SQL Server instance defined with the -SS switch.   

-SN The Data Warehouse database name. This database will be created in the instance 
defined by -SS. An ODBC Source DSN of the same name will also be created on the PC. 

-a The ODBC DSN architecture. 

-AN  The RED application name. This is the name of the 'id' file and is typically of the structure 
app_id_XXXX_vvvvvv.wst where XXXX is the application identifier and vvvvvv is the 
application version. For example, the tutorial application would be 
app_id_SQLT_tutorial_6.wst  

-AD The RED application directory. This is the directory in which the file defined by the -AN 
switch resides.  

-LI  The SQL Server instance that contains the source database. 

-LD  The ODBC source DSN name as defined in the Connection object in the data warehouse 
application. This ODBC source will be created. 

-LN The database name on the SQL Server instance as defined by the -LI switch. This is the 
database that contains the source data. 

-LT This switch does not have a parameter. If set, it flags the ODBC source DSN as defined in 
the -LD switch as a trusted connection. 

-JN The name of a job in the data warehouse that is to be run once all other tasks are 
completed. 

-CC The name of the cube connection if appropriate. If set, then all cubes will be updated to 
have this as the Analysis Services connection. 

-DC The name of the Data Warehouse connection if appropriate. If set, then all cubes will be 
updated to have this as their Source connection. 

-CD The name of the cube database in Analysis Services if appropriate. If set, then all cubes 
will be updated to have this database as their Analysis Services database. 

-ML The scheduler login name. 

-MP The scheduler password. 

For example, a batch file to call an application load of the tutorial may look as follows: 

@echo off 

c:\ 

cd \Program Files\WhereScape\ 

adm -QA -SS "WSL-TEST"  -SN new_dw -LT -AN app_id_SQLT_tutorial_3.wst  -AD "c:\Program 

Files\WhereScape\" -LI WSL-TEST -LD tutorial -LN tutorial -JN "Daily Update" -CC Cubes -CD 

My_database -DC DataWarehouse 

exit 
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Teradata Installation and Configuration 

Introduction 

The steps provided here are an indication of the normal process required to install and configure WhereScape 
RED. In some environments additional processes will be required. 

1. Install Teradata Tools and Utilities 13.10 (or greater) or on a suitable computer. These tools and utility 
components are required: 

o CLI 
o Teradata ODBC Driver 
o BTEQ 
o Fast Load / Multiload or TPT 
o Fast Export 

2. Install the WhereScape RED software onto your PC. Refer to Installing RED for Teradata for details. 

3. Add your license key. Refer to Adding your License for details. 

4. Check your Windows version. Refer to Checking your Windows Version for details. 
5. Check your ODBC Drivers. Refer to Checking your ODBC Drivers for details. 

6. Designate a database or user that is to be used as the meta data database. For testing or evaluation 
purposes this database or user may be a Teradata Express database server. WhereScape RED requires 
the Teradata database version 15.10 or greater as the data warehouse database server. Record the 
database and server names for this database. Create a database user to hold the metadata tables.  

7. Allocate the privileges required by WhereScape RED. Refer to Creating a Teradata Environment for 
details. 

8. Add appropriate entries to the hosts file on the computer for the server. 

9. Add a definition of an ODBC data source to connect to the data warehouse database. Refer to Configuring 
a Teradata Metadata Connection (DSN) for details. 

10. Create the WhereScape metadata repository under the data warehouse user that you created. Refer to 
Creating a Metadata Repository for Teradata for details. 

11. Install a Windows Scheduler. Refer to Installing a Windows Scheduler for Teradata for details 

12. Install a Unix Scheduler. Refer to Installing a Unix Scheduler for Teradata for details. 

13. Install a Teradata Unix Loader. Refer to Installing a Teradata Unix Loader for details. 

14. If required, load the WhereScape tutorial tables into a separate database. It is highly recommended that the 
tutorials be undertaken. Refer to Creating Tutorial Data for details. 

Problem Solving 

If problems occur in your install that cannot be resolved, proceed as follows when running WhereScape's Setup 
Administrator utility: 

1. Create a log file by selecting Tools > Start Logging from the menu bar. Enter a file name. 
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2. Step through at least: 
o Computer Setup > Check Windows version. 
o Computer Setup > Check ODBC driver. 
o Computer Setup > Validate/Add Odbc source. 
o Create/Validate Meta Repository > Validate meta repository. 

3. Select Tools > Stop Logging to close off the log. 

4. Edit the log and remove any passwords that appear. 

5. Send your log file to support@wherescape.com. 

Installing RED for Teradata 

Installation Prerequisites 

WhereScape RED requires certain client and server components. 

Client Prerequisites 

• Windows 10 and Windows 11. 

• 2GB available disk space. 

• ODBC Version 3.0 (normally shipped as part of the Operating System). 

• For building a data warehouse, Teradata Tools and Utilities 15.10 or greater is required. 

Server Prerequisites 

• One of the following data warehouse database platforms is required: 15.10, 16.00, 16.10, 16.20. 

• To use the WhereScape RED Scheduler, a UNIX, Linux or Windows based server is also required (this 
may be the database server). WhereScape RED only supports sh and ksh under UNIX and bash under 
Linux. 

• When installing a Unix/Linux scheduler, the server will need to have Teradata Tools and Utilities for 
Linux/UNIX installed and configured as a prerequisite before the scheduler can be installed. 

Installation of WhereScape RED 

To install WhereScape RED, refer to Installing WhereScape RED for details. 

Creating a Teradata Environment 

The creation of the Teradata repository and user(s) that are used to administer and maintain the data warehouse 
must be performed outside of this utility.  

The RED repository is recommended to be a Teradata database for a more secure database environment.  

WhereScape recommends following Teradata best practices related to ROLEs and PROFILEs but does not 
mandate they be used. 

RED repositories require these permissions for administration: 

GRANT EXECUTE, SELECT, INSERT, UPDATE, DELETE, STATISTICS, SHOW, TABLE, VIEW, MACRO ON 
RED_REPOSITORY TO RED_REPOSITORY; 
GRANT EXECUTE PROCEDURE ON RED_REPOSITORY TO RED_REPOSITORY WITH GRANT OPTION; 

RED developers do not need TABLE or VIEW permissions to the repository database. 
RED developers only require INSERT, UPDATE, DELETE and SELECT on metadata repository views. Please 
contact WhereScape should you need assistance in configuring a Teradata secure repository environment.  
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For DBC permissions the following is required: 

GRANT SELECT ON DBC.ErrorMsgs; – to log error messages into error logs. This is always accessed through 
the locking for access modifier.  
GRANT SELECT ON DBC.TablesV; – to describe Tables in a database within databases the user has permission 
to. 
GRANT SELECT ON DBC.ColumnsV; – to describe columns associated with a table within databases the user 
has permission to. 

Note: COLLATION 

If your Teradata database's default collation is UNICODE, please ensure that the user must be created with 
COLLATION = ASCII, DEFAULT CHARACTER SET LATIN; 

 

As an example, for our data warehouse, or decision support system, we will create a user, 'dssdemo'. An example 
SQL script to create this 'dssdemo' user is shipped and can be found in the WhereScape RED program directory: 

• ..\Teradata\Recreate_dssdemo.sql 

 This script needs to be modified to reflect the Teradata environment created at your site. 

Note: Timezone Settings 

Teradata can generate CURRENT_TIMESTAMP, CURRENT_TIME and CURRENT_DATE to reflect the session 
time and session time zone (as opposed to the current date and time on the Teradata server).  
This can result in date/time/timestamp comparisons behaving unexpectedly and impact the RED scheduler. A 
Teradata Customer Service Engineer can configure this using a DBSCONTROL field called TimeDateWZControl.  
 
The values for TimeDateWZControl are:  
1 (disabled)  
2 (enabled with UTC i.e. all datetime data is stored in UTC on disk)  
3 (enabled with LOCAL i.e. all datetime data is stored in system LOCAL time on disk)  
0 (returns the field to disabled)  
 
Please ensure TimeDateWZControl is disabled, if you are not using temporal fields.  

 

Configuring a Teradata Metadata Connection (DSN) 

To begin adding an ODBC Source from WhereScape's Setup Administrator, refer to Creating an ODBC 
Connection for details. 

1. In ODBC Data Source Administrator, click on the System DSN tab to view the system wide ODBC 
entries.  

o Click on the 'Add...' button to add a new entry. 

2. Select a Teradata driver from the driver list. 
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3. A pop-up as shown below appears.  

o Enter a Name for the Data Source.  

o Next, enter the Name or IP Address for the Teradata Server Info.  

o The Session Character Set field must be set to ASCII - this is the only character-encoding scheme 
supported for Teradata. 
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Note 

The name entered for the Teradata Server Name should appear in the hosts file on the computer in 
this form: 
 
(IP address) (Teradata Server Name) (Teradata Server Name)Cop1  
For the example in the ODBC screen shot above for TD_14_00, this entry would present if the server 
had an IP address of 10.12.123.60 and a name of "TD_14_00": 
10.12.123.60 TD_14_00 TD_14_00Cop1 
 
An alternative approach is to add the same entry to a dynamic name server (DNS). 

 

4. If using the ODBC source for a RED Scheduler, click Run in Quiet Mode.  

o Click OK. 
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5. Click OK again. 

Tip 

If multiple PCs will access the data warehouse, they must all use the same data source name as entered here. 

 

Creating a Metadata Repository for Teradata 

1. In WhereScape's Setup Administrator, click on the Metadata Repository tab in the left pane and then 
click on the Create Metadata Repository icon. 

This option will create the WhereScape meta tables, sequences and procedures in the specified schema.  
It checks to ensure that the schema, database or user does not contain an existing metadata repository 
before starting the metadata install. 
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2. After clicking on Create Metadata Repository, enter the ODBC Connect, User Name and Password or 
TD Wallet String. 

o Click OK. 

 

3. When creating a Teradata metadata repository, two additional screens are displayed: 

o First, a dialog is displayed for the Teradata server name (TDPID). Enter the TDPID. 

o Click Test and Use. If you skip the test and provide an invalid or wrong Teradata TDPID, native 
loads will not work in WhereScape RED. 
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Note 

The name entered for the Teradata Server Name should appear in the hosts file on the computer in 
this form: 

(IP address) (Teradata Server Name) (Teradata Server Name)Cop1  
For the example in the ODBC screen shot above for TD_14_00, this entry would present if the server 
had an IP address of 10.12.123.60 and a name of "TD_14_00": 
10.12.123.60 TD_14_00 TD_14_00Cop1 

An alternative approach is to add the same entry to a dynamic name server (DNS). 

 

4. A second additional dialog is displayed for the Metadata Repository database.  

o Enter the name of the user or database in which the metadata repository is being created. 

o Click OK. 
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Oracle Installation and Configuration 

Introduction 

The steps provided here are an indication of the normal process required to install and configure WhereScape 
RED. In some environments, additional processes will be required. 

1. Install the Oracle 10g, 11g or higher database client software on a suitable PC. 

2. Install the WhereScape RED software onto your PC. Refer to Installing RED for Oracle for details. 

3. Add your license key. Refer to Adding your License for details. 
4. Check your Windows version. Refer to Checking your Windows Version for details. 
5. Check your ODBC Drivers. Refer to Checking your ODBC Drivers for details. 

6. Designate a database that is to be used as the data warehouse database. For testing or evaluation 
purposes this may be a PC based database. WhereScape RED requires the Oracle database version 10.1 
or greater as the data warehouse database. Record the SID for this database. Create the database user 
(schema) that is to be used to hold the metadata and data warehouse tables. Allocate the privileges 
required by WhereScape RED. Refer to Creating an Oracle DSS User for details. 

7. Establish the Oracle Net connections required to allow access to the data warehouse database from the 
PC. Record the Server name for the connection. 

8. Add the definition of an ODBC data source to connect to the data warehouse database. Refer to 
Configuring an Oracle Metadata Connection (DSN) for details. 

9. Create the WhereScape metadata repository under the data warehouse schema that you created. Refer to 
Creating a Metadata Repository for Oracle for details. 

10. Install a Windows Scheduler. Refer to Installing a Windows Scheduler for Oracle for details. 

11. Install a Unix Scheduler. Refer to Installing a Unix Scheduler for Oracle for details. 

12. If required, load the WhereScape tutorial tables into a separate database. It is highly recommended that the 
tutorials be undertaken. Refer to Creating Tutorial Data for details. 

Problem Solving 

If problems occur in your install that cannot be resolved proceed as follows when running WhereScape's Setup 
Administrator utility: 

1. Create a log file by selecting Tools > Start Logging from the menu bar. Enter a file name. 
2. Step through at least: 

o Computer Setup > Check Windows version. 
o Computer Setup > Check ODBC drivers. 
o Computer Setup > Validate/Add Odbc source. 
o Oracle> Validate Oracle user privileges (if an Oracle DataWarehouse). 
o Create/Validate Meta Repository > Validate meta repository. 

3. Select Tools > Stop Logging to close off the log 

4. Edit the log and remove any passwords that appear. 
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5. Send your log file to support@wherescape.com. 

Installing RED for Oracle 

Installation Prerequisites 

WhereScape RED requires certain client and server components. 

Client Prerequisites 

•  Windows 10 and Windows 11. 

• 2GB available disk space. 

• ODBC Version 3.0 (normally shipped as part of the Operating System). 

• For building a data warehouse, a version 11.2 database client or greater is required. A 32-bit or 64-bit 
Oracle client installation will be necessary (64-bit recommended). 

Server Prerequisites 

• One of the following data warehouse database platforms is required: Oracle version 11.2 or higher. 

• To use the WhereScape RED Scheduler, a UNIX, Linux or Windows based server is also required (this 
may be the database server). WhereScape RED only supports sh and ksh under UNIX and bash under 
Linux. 

Installation of WhereScape RED 

To install WhereScape RED, refer to Installing WhereScape RED for details. 

Notes: 

The WhereScape RED installer selects the following installation directory as the default location for RED on a 64-
bit windows server: C:\Program Files (x86)\WhereScape. This is where 32-bit applications normally reside on a 
64-bit Windows platform. 

However, if Oracle 10g is involved, either as the data warehouse repository, or as a source system, installing RED 
in “Program Files (x86)” can cause an issue. Oracle does not like directories that have a parenthesis in their 
name. Applications using Oracle cannot be located in such a directory. This includes WhereScape RED using 
ODBC to connect to Oracle. The result is that WhereScape RED will not be able to connect to Oracle. (This issue 
does not usually occur with Oracle 11g). To prevent this, change the installation directory of WhereScape RED. 
Options include: 
 
C:\WhereScape 
D:\Program Files\WhereScape (if a second drive is available) 
 
It is not good practice to install 32-bit applications in C:\Program Files\WhereScape on a 64-bit machine. 

 

Creating an Oracle User 

The creation of the Oracle database user that will be used to administer and maintain the data warehouse must be 
performed outside this utility. The SQL Admin utility can be used to execute the sql required to create such a 
user, or the database administrator should be contacted. 

A list of the required privileges is displayed when this option is selected. Many of these privileges must be 
allocated as specific privileges and cannot be granted as part of a role. For example, if a 'grant dba to dssuser' 
command is executed WhereScape RED will still need these privileges specifically granted as 'dba' is a roll.   
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Note 

WhereScape RED makes use of the dbms_lock and dbms_sql packages supplied by Oracle. When using Oracle, 
privileges obtained by the owner via a role cannot be referenced in a procedure. Therefore, RED requires that 
these privileges be granted to the user. This is an Oracle restriction and not something imposed by WhereScape. 

 

For our data warehouse, or decision support system, we will create a user, 'dssdemo'. An example sql script to 
create this 'dssdemo' user is shipped and can be found in the WhereScape RED program directory: 

• ..\Oracle\Recreate_dssdemo.sql 

Notes 

• This script need to be modified to reflect the data warehouse schema chosen at your site. An example 
script follows below.  

• This script would normally need to be run under the sys user. 

 

1. The dss user created is dssdemo in this case: 

drop user dssdemo cascade; 

create user dssdemo identified by wsl; 

alter user dssdemo default tablespace DEMODATA; 

alter user dssdemo temporary tablespace TEMP; 

  

grant create session to dssdemo; 

grant resource to dssdemo; 

grant create table to dssdemo; 

grant create view to dssdemo; 

grant create sequence to dssdemo; 

grant create procedure to dssdemo; 

grant select any table to dssdemo; 

grant create materialized view to dssdemo; 

grant create database link to dssdemo; 

grant query rewrite to dssdemo; 

grant select on sys.v_$database to dssdemo; 

grant alter session to dssdemo; 

grant select on sys.v_$session to dssdemo; 

grant execute on sys.dbms_lock to dssdemo; 

grant execute on sys.dbms_sql to dssdemo; 

grant create any view to dssdemo; 

grant unlimited tablespace to dssdemo; 

grant alter system to dssdemo; 

grant select_catalog_role to dssdemo; 

  

Notes 

• select any table - this is only required to gain access to tables in other schema. It is not required if specific 
grants have been provided to the tables that are required, such as with the tutorial. 

• alter system - some dbas do not like granting the ALTER SYSTEM privilege as it is very powerful. With 
this privilege, you can make wide reaching changes including altering initialization parameters. RED only 
uses ALTER SYSTEM to kill jobs. Rather than granting ALTER SYSTEM, you can compile Ws_User_Abort 
(contained in C:\Program Files\WhereScape\Oracle) under the SYS user. Then grant execute on 
SYS.Ws_User_Abort to dssdemo. 

 

2. To use object placement across multiple schemas in WhereScape RED, the RED user also needs to be 
granted the following privileges: 
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grant select any table to dssdemo;  

grant create any view to dssdemo;  

grant drop any view to dssdemo;  

grant create any table to dssdemo;  

grant drop any table to dssdemo;  

grant delete any table to dssdemo;  

grant insert any table to dssdemo;  

grant update any table to dssdemo;  

grant alter any table to dssdemo;  

grant global query rewrite to dssdemo;  

grant create any materialized view to dssdemo;  

grant drop any materialized view to dssdemo;  

grant alter any materialized view to dssdemo;  

grant create any index to dssdemo;  

grant drop any index to dssdemo;  

grant alter any index to dssdemo;  

grant select any sequence to dssdemo;  

grant create any sequence to dssdemo;  

grant drop any sequence to dssdemo;  

grant analyze any to dssdemo;  

grant comment any table to dssdemo;  

  

 grant select_catalog_role to dssdemo;  

3. To do loads from Hadoop using multiple schemas, the RED user also needs to be granted the following 
privilege: 

grant select_catalog_role to dssdemo; 

4. To use the Data Vault 2 templates, the RED user also needs to be granted the following privilege: 

grant execute on dbms_crypto to dssdemo; 

Creating Oracle Individual Users 

Oracle users that require each developer to log into Oracle (using their own username and password), can 
use the Oracle Individual User Logon Method. 

The Oracle Individual User option allows a user, with the appropriate permissions, to log into WhereScape 
RED and then operate as the RED schema. 

This method enables customers to configure RED ensuring that users logged in via this method cannot edit 
the metadata user password in the connections, and ensures that the password is encrypted in Tools > 
Options. 

To authorize users to log in to RED using the Oracle Individual User method, a DBA needs to grant users 
select on the ws_dbc_connect table, as well as the CREATE SESSION system privilege. 

This method is also useful for tracking individual WhereScape RED user activity in the Oracle database. 
Their authenticating user name is now stored in the CLIENT_IDENTIFIER field of v$session which can be 
used by Oracle’s auditing, functioning to track individual developer activity. 

Oracle individual users will need to be created and granted certain privileges. Alternatively, for existing 
Oracle database users, they just need to be granted the following privileges below: 

grant create session to oracle_user1  

grant select on dssdemo.ws_dbc_connect to oracle_user1  

1. Once logged in to RED, the metadata user needs to do the following in Tools > Options > Repository 
Privacy settings: 

o Check the option to enable the Mask Extract User Password. 
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o Deselect the option to deactivate the Extract User Password Editing (this will lock down the 
metadata user password in the connections). 

o Check the option to enable the Mask Admin User Password. 

o Deselect the option to deactivate the Enable Admin User Password Editing (this will lock down the 
Admin/Dss User Password in the connection properties). 

Note: Encrypt User/Admin User Password Options 

Users should also check the options to enable Encrypt User Password and Encrypt Admin User 
password as shown in the example screen below.  

 

 For UNIX/Linux scheduler processing User and Password Encryption implications, please refer to 
section Settings - Repository Privacy Settings in the RED User Guide.  

 

2. Multiple users can then log in to RED using their own credentials by: 

o Selecting the Oracle Individual User option from the Logon Method drop-down menu. 

o Entering their user name and password. 

o Entering the RED schema. 
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3.  The Repository Privacy Settings is completely unavailable for users that log in to RED via the Oracle 
Individual User method. 

 

Tip: Oracle Individual User System Information 

The permissions below are required to list and see user session, session locks and user locks information for 
Oracle individual users.  

grant select on sys.v_$sql to dssdemo;  
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Tip: Oracle Individual User System Information 

grant select on sys.v_$sess_io to dssdemo;  

grant select on sys.v_$locked_object to dssdemo;  

grant select on sys.v_$lock to dssdemo;  

 

Configuring an Oracle Metadata Connection (DSN) 

WhereScape RED supports the Oracle ODBC driver, follow the instructions below for setting up this driver. 

To begin adding an ODBC Source from WhereScape's Setup Administrator, refer to Creating an ODBC 
Connection for details. 

Setting up an Oracle ODBC Driver 

1. In ODBC Data Source Administrator, click the System DSN tab to view the system wide ODBC entries.  

o Click the 'Add...' button to add a new entry. 
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2. Select the Oracle ODBC driver from the driver list.  

o Click Finish. 

 

3. Enter the ODBC Data Source Name (DSN) details in the Oracle ODBC Driver Configuration screen. 
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4. To test the connection, click Test Connect, otherwise click OK.  

Validating Oracle User Privileges 

1. To validate the Oracle user privileges, click the Oracle tab and then click Validate Oracle User Privileges. 

 

This option tests that an ODBC connection can be made to the Oracle database running the data 
warehouse. 

The diagram below shows some of the layers involved in making up this type of connection. 
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If this connection fails, then we need to isolate where the failure is occurring. The Oracle documentation can aid in 
resolving the problem. Starting from the bottom and working back up the layers we can perform the following tests: 

1. Log on to the host running the database, and check that a direct connection to the database works via a 
tool, such as sqlplus. This will test that the database is active and receiving connections. 

2. Issue a Tnsping from a dos shell on the PC (e.g. tnsping ORCL) where ORCL is the tnsnames connection 
entry for the data warehouse database. This will check the Oracle network layer. If the Tnsping responds 
with an OK, then the database server is visible through the network layer. 

3. Connect to the data warehouse database using sqlplus from the PC. Again, this test checks the network 
layer and a small part of the Oracle client software. 

4. Attempt an ODBC connection using the Oracle supplied ODBC tool (normally called Oracle ODBC Test 
and located within the Oracle program menu). This tool is normally loaded as part of the Oracle client. It 
provides an independent test of the ODBC, Oracle client and network layers. Initially attempt to connect 
using the Oracle supplied ODBC driver. This will confirm that all layers apart from the ODBC driver are 
working correctly. If a failure occurs consult the Oracle documentation. 

5. Perform the same test as step (4) but this time using the Microsoft® ODBC for Oracle driver. 
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Notes: 

A connect error NA000 usually means the ODBC driver is not functioning correctly. This may be due to a 
Microsoft® service pack dependency. Acquire the ODBC drivers from Microsoft® and try again. The file is 
mdac_typ.exe and is a free download from Microsoft®. 

Some combinations of the Oracle client software and the Microsoft® ODBC driver for Oracle result in a connection 
error NA000. If the connection fails and all other possibilities have been checked then the following may address 
the problem on Windows 2000 systems. 
 
Run RegEdit 
Under the HKEY_LOCAL_MACHINE\ SOFWARE\ Microsoft\ MSDTC\ MTxOCI entry edit OracleOciLib and set it 
to Oci.dll (The default is Ociw32.dll). 
 
Another common problem is where multiple Oracle homes are in use (especially where Oracle Discoverer has 
been installed). Ensure that the PATH variable references an 8.1.7 or later Oracle directory. The OCI used by the 
Microsoft® odbc driver utilizes features not found in older versions of the OCI.   

 

If you are still unable to connect, record the error message as displayed on connection failure and contact 
support@wherescape.com.  

The following example shows the error message "2800 (Microsoft®)(ODBC driver for Oracle)ORA_01017: invalid 
username/password; logon denied". 
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Creating a Metadata Repository for Oracle 

1. In WhereScape's Setup Administrator, click the Metadata Repository tab and then click Create 
Metadata Repository. 

 

2. This option creates the WhereScape meta tables, sequences and procedures in the specified schema. It 
checks to ensure that the schema, database or user does not contain an existing metadata repository 
before starting the metadata install. 

o Click Create Metadata Repository. 
o Enter the ODBC Connect, User Name and Password and then click OK. 

 

3. When creating an Oracle metadata repository, an additional window is displayed requesting Tablespace 
information. 

o  Select the required Tablespaces and then click OK.  
o  If Tablespaces are not specified, the user's default Tablespace will be used.  
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4.  Depending on the type of license you have, the following dialog may be displayed:  
o  If it is displayed, select the type of repository required and then click OK.  

 

Note: 

o Repository Types: This is just setting the default objects visible in RED. They can later be 
changed in RED under Tools > Options. 

o Data Vault Repository Type: Depending on the license type, users may have different repository 
type choices available. Choosing a Data Vault repository type will create a metadata repository in 
RED with more appropriate Data Vault repository default settings, such as Object Type Names, 
Global Naming of Tables, Indexes, Key Columns and Procedures/Scripts, as well as other 
repository settings/user preferences.  

 

5.  The procedure compile dialog is displayed:  
o  To force the compilation under the Oracle 8i standard, select the check-box on the right bottom 

corner of the Procedure Compile window. Otherwise, click OK.  
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6. If a procedure fails to compile, then scroll to the right in the right pane to see if any of the returned error 
codes help in ascertaining what the problem is. 

For Oracle common causes of procedure compilation failures are: 

o  Running an Oracle version prior to 11.2.  
o  Insufficient room in the SYSTEM table space.  
o  Insufficient privileges. (See notes below).  
o  Memory parameters set too small in the Oracle instance.  

Insufficient privileges on procedure compile (Oracle) 

Compiles of the WhereScape procedures may fail where the required privileges have not been granted. The bulk 
of the WhereScape procedures are used by the scheduler, so they can be left uncompiled, if the scheduler is not 
to be used. The following procedures however must successfully compile for WhereScape RED to function 
correctly: 

Ws_Procedure_Save, Ws_Procedure_Compile, WsWrkAudit, WsWrkError, WsParameterRead and 
WsParameterWrite 

If one or more procedures fail to compile then use the Validate Metadata Repository option to compile the 
procedures, once the problem has been rectified. 
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Tutorial Data 
The tutorial data component of WhereScape's Setup Administrator attempts to validate, upgrade or perform an 
initial install of the WhereScape tutorial tables.  

The tutorial tables are only required if the tutorial is to be undertaken. They can be ignored if desired.   

1. Click the Metadata Repository tab in the left pane and then click either: 
o The Create Tutorial Data option to create (or re-create) the set of tables in the specified schema 

(user). 
o The Validate Tutorial Data option to check for the existence of WhereScape RED tutorial tables. 

 

Creating Tutorial Data 

1. In WhereScape's Setup Administrator, click the Metadata Repository tab and then click Create Tutorial 
Data. 
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This option creates or re-creates the WhereScape tutorial tables within the schema (user) or database provided. 
The normal practice is to locate these tables in a different schema from the data warehouse user for Oracle and in 
a different database for SQL Server. The data warehouse user will need select access to these tables to perform 
the tutorial. The tutorial documentation assumes these tutorial tables will be loaded under the user 'wtutorial' for 
Oracle or in the Tutorial database for SQL Server. Another user or database may be used if desired. The user 
chosen must have sufficient privileges to allow the creation of the tables. 

When this option is selected, an ODBC connection dialog appears and if a valid user is entered the tables will be 
created and populated under the specified user. 
Please ensure that no tables that match those shown in the Validate tutorial tables section exist under the 
specified user. If existing tables are found, a prompt is issued, and if proceed is chosen then all data will be 
deleted from the tables and the tutorial data loaded. 

Teradata 

When creating tutorial tables for Teradata, an additional dialog is displayed for the user or database name that the 
tutorial data will be created.  

• Enter the name of the user or database in which the tutorial data will be created and click OK. 

Validating Tutorial Data 

1. In WhereScape's Setup Administrator, click the Metadata Repository tab and then click Validate 
Tutorial Data . 
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The tables are based around a simple sales model and are as follows: 

This option validates that the tutorial tables exist in the given schema. 

Table Contents 

product  A list of products including a product code (sku), description, group and 
subgroup.  

prod_group  A description of each product group.  

prod_subgroup  A description of each product sub group.  

prod_line  A description of each product line.  

code_table  A table containing the codes and descriptions for product groups, sub groups 
and lines. A code type of 'pg','sg' and 'pl' is used to differentiate the different 
codes.  

customer  A list of customers containing names and addresses.  

order_line  The lines on a sale. Includes the specific product code, quantities and values.  

order_header  The header for a sale. Includes the customer code, order data and ship date.  

kpi  Used to generate a KPI dimension.  

budget  Budget data for sales of products to customers.  

forecast  Demand forecast data for products and customers.  
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Applications 
The application component of WhereScape's Setup Administrator attempts to list, upgrade or perform an initial 
install of a third-party supplied data warehouse application. 

1. Click the Application tab in the left pane and then click: 
o Application Load - Refer to Loading an Application to load the metadata, tables procedures, 

scripts etc. provided as part of the application. 
o Change Application Directory - Refer to Changing the Application Directory  to change the 

directory of applications to be installed. 
o List applications in Repository - Refer to Listing Applications to list all applications that have 

been applied to the chosen metadata repository. 

 

Loading an Application 

1. In WhereScape's Setup Administrator, click the Application tab and then click Application Load . 

../../../Content/Installation%20Guide/Creating%20and%20Loading.htm#O_3891
../../../Content/Installation%20Guide/Creating%20and%20Loading.htm#O_3891
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Loading an application inserts various objects into the chosen metadata repository. An application is best defined 
as a set of objects that are shipped to allow inclusion of those objects into a remote repository. 

Note: 

An application can only be loaded into a metadata repository running on the same database type as the 
application creator. (e.g. An Oracle application cannot be loaded into a SQL Server metadata repository). 

 

During the load of an application a number of cross environment mappings need to be resolved. These are: 

Connections 

Connections are normally unique for each metadata repository. They provide the path to the source data and this 
nearly always varies. Even though an application can ship a set of connections, these connections will nearly 
always need modification. Alternatively, a connection shipped with an application may map to an existing 
connection, and this can be done as part of the load process. If you are unsure whether or not a connection is 
required, it can be added and later modified. 

Tablespaces (Filegroups in SQL Server and Databases in Teradata) 

If an application ships table or index objects, then these objects will typically have a tablespace (filegroup in SQL 
Server and database in Teradata) associated with them. During the load, it is necessary to map these tablespaces 
(filegroups in SQL Server and databases in Teradata) to those available for the metadata repository. 

Object Changes 

The application may ship objects that already exist in the metadata. In such a case, the process during the load is 
to create a version of the existing object and then replace it with the new object. At the start of the load, a check is 
made to see if any objects will be replaced. If the application is a patch or an upgrade of an existing application 
version, then this will be normal. The load can be stopped at this point to allow for further investigation. 
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Table Changes 

If the load replaces table objects, it may in turn need to alter the physical table in the database to match the new 
definition. Again, if this is a patch or an application upgrade, this may be desirable. If not, the proposed actions 
should be reviewed before proceeding. 

Procedure Changes 

New procedures, scripts, or modifications may be loaded as part of the application load. In the case of procedures, 
the procedures need to be recompiled. The load can perform this action, but any failures or issues needs to be 
resolved after the load has been completed. 

The following section covers the actual application load process. 

Notes: 

• It is always a good idea to backup the WhereScape RED metadata before running an application load. 
Refer to Backing Up the Metadata before Loading Applications for details. 

• Some database operations, such as converting existing non-partitioned tables to partitioned tables, cannot 
be done using a deployment application. In such cases, some manual intervention may be required to 
update the target databases to match the new metadata. 

 

Backing Up the Metadata before Loading Applications 

It is always a good idea to backup the WhereScape RED metadata before running an application load. 

A metadata backup can be used to restore the metadata to the state before the application was loaded. 

There are three options for backing up the metadata: 

1. In RED, use the Backup > Unload the metadata to disk option to unload the metadata to a WhereScape 
Proprietary backup. Refer to Unloading Metadata in the WhereScape RED User Guide for more 
information. 

2. In RED, use the Backup > Export the metadata option to backup the metadata, using the data warehouse 
database's backup utility. Refer to Backup using DB Routines in the WhereScape RED User Guide for 
more information. 

3. In RED, use the Tools > Build application tables option to build an application of the objects being 
replaced. This is achieved by selecting the new application files you're about to load in the Previous 
application box of the Define and build an application distribution window. Refer to Application Creation 
in the WhereScape RED User Guide for more information. 

Note: 

If the table changes in the application are being applied to the data warehouse database, then it is also a good 
idea to backup the data warehouse tables being changed. 

 

Application Load Process 

An application consists of multiple files that are loaded from a directory. The default directory is the WhereScape 
program directory. Another directory may be specified by clicking the Change Application Directory button. The 
last selected application directory is the default directory for the next application load. 

Once the directory has been selected, the application load is started by clicking the Application Load button. This 
displays the available applications in the right pane. 

Note: 

If the Change Application Directory button was used, the list of available applications will already be displayed 
and the Application Load button doesn't need to be clicked. 

 



WhereScape® RED Installation Manual 

  

© Copyright, WhereScape, Inc. All rights reserved. - 68 - 

An example application list follows: 

 

• To load an application, either right-click the Application from the list and select Install Application from the 
pop-up menu or double-click the Application. Ensure the Application being installed has the same database 
type as the Metadata Repository, otherwise installation will fail. 

• Once this menu option is chosen, enter the ODBC data source and logon to the meta repository and click 
OK. 

Notes: 

Applications created in 3D cannot be loaded into the latest version of RED if they were created in WhereScape 3D 
before version 2.8.0.0. To complete the application load process; export the XML file from the latest version of 3D 
OR complete the application load process in a version of RED earlier than 6.8.6.3. 

 

 

 1. Teradata Applications 

• When loading an application into Teradata, the TDPID will be tested. If the TDPID test fails at this stage, a 
dialog will appear asking you to enter the correct TDPID. Click Test and Use after entering the TDPID and 
relevant credentials. If you skip the test and provide an invalid TDPID, native loads will not work in 
WhereScape RED. Teradata native loads use bteq which connects natively to the database using its own 
internal protocols without using the ODBC driver. Therefore, ODBC settings are not relevant in this process 
and a valid Teradata TDPID is required to load application procedure and scripts successfully using native 
load.  

• After the TDPID check, an additional dialog is displayed for selecting the metadata repository database. 
Select the database and click OK.  

 

2. Oracle applications 

When loading an application into Oracle, the TNS Name will be tested. If the TNS Name test fails at this stage, a 
dialog will appear asking you to enter the correct TNS Name. 
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Click Test and Use after entering the TNS Name. If you skip the test and provide an invalid TNS Name, native 
loads will not work in WhereScape RED. 

 

A list of all the objects in the application is displayed in the right pane. Each object is identified as either new to the 
metadata, or as a replacement for an existing object. For example: 

 

A window appears after the list has been displayed, advising of what is to occur. You may cancel the application 
load at this point and review the objects to be replaced. The load can then be continued by using the right-click 
menu option when positioned over any object. 

Click OK to proceed with the application load. A new window appears providing options for the application load: 
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If you click OK, the objects are inserted into the metadata.  
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Metadata Options 

 

Application Files 

Option Description 

Application Identifier  The application identifier is a four character code used to uniquely identify the 
application. This identifier is used in the naming of the files that are created to contain 
the application data.  

Application Version The version is a character string that provides a version number for reference purposes. 
This version number is displayed when applications are being loaded and is used in the 
naming of the files that are created to contain the application data. As such, it must 
contain characters that are valid in a Windows file name. 

Application Database 
Type 

The database type from which the application was built. An application can only be 
loaded into a metadata repository running on the same database type from which the 
application was created—(e.g. An application created from Oracle database cannot be 
loaded into a SQL Server metadata repository). 

General Options 

Option Description 

Use Native Load for 
Metadata Procedures 
and Scripts  

This option causes the metadata for procedures and scripts to be loaded into the target 
metadata repository, using the target repository's load utility instead of ODBC.  
This can have significant performance advantages when loading large applications, 
when loading applications into a slow target database or over a slow network.  
The loaders used are: SQL*Loader for Oracle, bcp for SQL Server and BTEQ for 
Teradata data warehouses. 

Map 
Tablespace/Filegroups 
to the same name 

Every table in Oracle is located in a tablespace. SQL Server tables may be in 
filegroups.  
If this option is set, existing tablespaces and filegroups in the target data warehouse 
database will automatically be matched to their same ones on the source repository.  
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Option Description 

If the tablespace/filegroup does not exist in the target data warehouse database, a 
Tablespace selection window pop-ups so a tablespace/filegroup can be selected. This 
window appears once for each tablespace/filegroup that cannot be matched. 
 

Note: 

This option is not available for Teradata. 
 

Apply 
Group/Project/Object 
Relationships 

If this option is set to True, the project group relationships are updated in the target data 
warehouse database. 

Generate load scripts 
and update routines for 
objects 

If this option is set to True, the deployment will include the generation of load scripts and 
update routines for the table objects, but only if: 

• the code generation is template based. 

• a default load script and update routine template is set for the object type in the 
target connection 

• the default build options satisfy the requirements of the default template. 

Refer to the Connection Properties and Rebuilding Update Procedures sections of the 
RED User Guide for details. 
 
This option can be used by Data Vault customers who utilize WhereScape 3D to import 
table objects into RED via deployment applications.  
This setting is enabled by default for 3D applications so that when the objects are loaded 
into RED during deployment, their initial update scripts or routines are also generated.  
This option defaults to 'OFF' during the deployment of applications generated by RED. 

Enable auto generation 
of indexes 

If this option is set to True, the deployment will also include the generation of indexes for 
the table objects after the update routines are generated. 

Existing Parameters will 
be 

Enables you to specify the action for existing parameters. 
The options are:  

• Updated/Overwritten 

• Retained 

• Renamed 

User Name Enables you to enter a username which is included in the versioning comments. 

Permanent Stage Table 
Options Hidden 

Enables you hide the Permanent Stage Table object options in the window.  
Save Settings must be used to save the option selection. 
This window does not refresh upon changing this option. 

 

Connections 

Option Description 

Map Connection 
References to the same 
name 

During deployment, objects need to be associated with a Connection. Setting this option 
to False causes the user to be prompted to choose a Connection for each object.  
Setting this option to True causes the WhereScape RED Setup Administrator to 
compare the name of all existing connections within the Data Warehouse with the 
Connection name defined in the deployment application for the current object.  
If the names match, then the WhereScape RED Setup Administrator deploys the object 
to this Connection. If no Connection name matches, then the user is prompted to choose 
a Connection. 

Map Target References 
to the same name 

During deployment, objects need to be associated with a target within a Connection. 
Setting this option to False causes the user to be prompted to choose a Target for each 
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Option Description 

object.  
Setting this option to True causes the WhereScape RED Setup Administrator to 
compare the name of all existing Targets within the Connection that has been either 
selected by the user or matched automatically. 
If the names match, then the WhereScape RED Setup Administrator deploys the object 
to this Target. If no Target name matches, then the user is prompted to choose a Target. 
Choosing a Target involves choosing a Connection—the WhereScape Setup 
Administrator automatically selects a Connection. If required, the WhereScape RED 
Setup Administrator selected Connection can be overridden using the GUI. 

Add Connections as 
required 

If this option is set to True, all Connection objects included in the application that do not 
exist in the Target metadata repository which are used by objects in the application will 
be added to the Target metadata repository. 

Jobs 

Option Description 

Assign Jobs to User  All jobs in the WhereScape RED scheduler belong to a user. If this option is marked as 
true, the user name specified in the User name for any jobs added by the application 
drop-down is set as the user name of all jobs loaded by the application. If the specified 
user name does not exist, it is then created. 

Existing Jobs will be Enables you to specify the action for existing jobs. 
The options are: 

• Updated/Overwritten 

• Retained 

• Renamed 

Object Source Mapping Sets 

This option is only available when applications are being deployed from 3D to RED. 

 

Option Description 

Existing Source 
Mapping Sets will be  

Existing Source Mappings Sets for an Object have three merge strategies: 

Replaced: Replaces the entire Source Mapping Set (Source Mappings can be removed 
in this mode) 

Merged using Application: Merges the Sets, resolving conflicts by deploying Source 
Mappings from this Application. 

Merged using Repository: Merges the Sets, resolving conflicts by retaining Source 
Mappings in the Repository, in other words, only deploy new Source Mappings. 
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Data Warehouse Options 

 

Option Description 

Apply Metadata 
Changes to Data 
Warehouse Objects  

If this option is marked as True, the changes contained in the application are applied to 
the metadata according to the options selected for each object type. 

Log Metadata DML and 
Data Warehouse DDL 
to a File 

If this option is marked as True, the changes contained in the application are written to a 
file. 

• DDL File - Option to enter or select the file name/path for the DDL file. 

• DDL File Statement Terminator - Option to specify the statement terminator. 

• Terminate lines with carriage return as well as new line - Option to terminate 
DDL file lines with a carriage return, as well as a new line. 

• Select encoding for DDL and Procedure files - Option to specify the encoding 
to be used for the DDL and Procedure files—options are UNICODE, ASCII or 
UTF-8. 

Compile New and 
Changed Procedures 

If this option is marked as true, then all procedure objects loaded by the application load 
are compiled in the target data warehouse database. 

Note: 

Depending on the type of database, invalid procedures may not compile. 
 

 

Data Warehouse Table/View Options 

 

For each table and view object loaded by the application load, it is possible to specify whether the metadata 
changes should be applied to the data warehouse table or view; and to the indexes on these objects. The change 
action can be specified by object type. New objects can have a different action to existing objects of the same 
type. Possible actions are: 

• Created - available for new tables and indexes of any object type 

• Recreated - available for existing tables and indexes of any object type 
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• Altered - available for existing tables and indexes of most object types (not available for load tables or 
views) 

• Nothing - available for all new and existing object types and indexes. 

The following additional settings can be configured when importing Load table objects from 3D to RED: 

• New Table Default Load Type, if not set in Source Connection 

• New Table Default Load Script Connection, if not set in Source Connection 

• New Table Default Load Script Template, if not set in Source Connection 

Note: 

The above default settings are only applied for new Load table objects, if these attributes are not defined in the 
Source Connection. They only apply for new Load table objects and Connections from 3D.  

 

This window also enables you to set whether or not new or existing objects are to be versioned. Set to True to use 
versioning, else set to False. 

 

Other options: 

• Alter allows columns to be dropped - This option enables you to set whether or not columns are allowed 
to be dropped by object type, for tables being altered. Set to True to allow columns that are not in the 
metadata, to be dropped; else set to False.  

• Allow alter table processing with non-compliant DDL - This option is used for custom database targets 
and sets whether or not to allow DDL statements that do not use a substitutable format for the table name 
to be used during validation, and subsequent alter table processing. Default setting is True.  
The DDL statements are set in the template that is defined in the custom database Connection properties 
(Connection > Target Settings > Default Table Create DDL Template) in RED. Refer to Connection 
Target Settings for Custom Database in the RED User Guide for details. 

WARNING: 

Setting this option to TRUE can lead to the DDL being run against the actual data warehouse table. 

 

The above options applies to Stage, Permanent Stage, Dimension/Model, ODS, Normal, Fact and Aggregate 
tables. 

Object action settings may be saved and reloaded later for another application using the Save Settings and Load 
Settings buttons. Supplied default settings may also be loaded by clicking the Default Settings button. 

  

The Connection Build Window 

The Connection Build window appears when the connection used by an imported table does not exist in the 
destination Data Warehouse. 



WhereScape® RED Installation Manual 

  

© Copyright, WhereScape, Inc. All rights reserved. - 76 - 

 

The Connection Build window is displayed if the following criteria are met: 

• If the connection the table uses is included in the exported files, but the Add Connections as required 
setting is disabled, the window is displayed with the Add Connection button. Clicking the Add Connection 
button adds the connection included in the exported files to the destination Data Warehouse. 

• If the connection the table uses is not included in the exported files, the window is displayed without the 
Add Connection button. The user is required to select an existing connection in the destination Data 
Warehouse. 

Tip: 

 If a new connection is added then it will need to be modified to match the database and user names of the new 
environment, on the relevant Connection Properties' dialog in WhereScape RED. 

Loading Applications with Targets 

When importing tables that contain Targets which do not exist in the destination Data Warehouse, users can 
select existing Targets from the list or add new ones, using the Add Connection/Target in the Resolve Target 
window, see the topic below for more information. 
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Adding Connections and Targets 

On the Add Connections and Targets screen, click the Add button to add your desired connection. 

 

Setup Administrator recognizes you are trying to import a table that references a specific connection type and that 
option will be selected by default in the Connection Type drop-down list. In the example below, Setup 
Administrator recognizes a tabular table imported from a Microsoft Analysis Services 2005+ connection and 
selects it. 

Type in the connection details and then click OK to create the connection. 
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The Filegroup /Tablespace Selection window 

Filegroups/Tablespaces may need to be manually remapped to the corresponding Filegroup/Tablespace available 
to the metadata repository. 

A window is displayed for each Filegroup/Tablespace encountered that is not automatically mapped (refer to 
Filegroup/Tablespace options above). 

 

The New Filegroup drop-down lists all filegroups visible to the repository. 

A window appears when the application load has been completed. The full results should be reviewed by scrolling 
back, or you can right-click and click Excel It to send the results to Microsoft Excel. 
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Creating and Loading Applications from the Command Line 

It is possible to create and load applications from the command line by running a batch file. The WhereScape RED 
Application directory contains an example batch file  WSL_Application_Create_Restore_Point_and_Load.bat for 
creating and loading.  

If you right-click this file and select Edit you will see the steps outlined, as well as the details on the options 
available. 

The first step creates a restore point application (R) based on objects about to be loaded. This process calls the 
command line functionality of RED and creates the application file. 

The second step loads an application (A) into a test WhereScape RED repository. It uses an XML Options File to 
specify various options, calls the command line automation functionality of Setup Administrator and loads the 
application (A). Ensure that you have already created and properly defined the XML Options File. Refer to XML 
Options File for Application Loads for details. 

The WhereScape RED Application directory contains example XML files: 

• WSL_Application_Load_SQL.xml for SQL Server 

• WSL_Application_Load_ORA.xml for Oracle 

• WSL_Application_Load_TER.xml for Teradata 

The tags in the XML Options File need to be edited because the login/connection details, etc. need to be set. 
Refer to XML Options File for Application Loads for details. 

The Batch Application Create options and the Batch Application Load options (described below) are listed at the 
end of the batch file. The values for these variables also needs to be customized before running this file.  

The process typically involves the following steps: 

1. Create an application (A) in RED containing your data warehouse changes. 

2. RUN WSL_Application_Create_Restore_Point_and_Load.bat from the command line; which creates a 
restore point application (R) and applies application (A) to a test WhereScape RED repository. 

3. If the changes are incorrect, they can be undone by loading the restore point application (R). 
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Batch Application CREATE Options 

The following options are available on RED to create applications. 

Option Description 

/BA Selects batch application create. 

/U  ODBC user name.  

/P  ODBC password.  

/C  ODBC DSN name.  

/A DSN Architecture 

/M  meta database for Teradata logon.  

/N RED User name. 

/D  Directory to save application files.  

/I  New application files identifier.  

/V  New application files version.  

/AP  Project name - all objects in a Project; and associated jobs.  

/AG  Group name - all objects in a Group; and associated jobs.  

/ALL  All objects - all objects, jobs and parameters.  

/RC  Remove connections - drop all connections from the application.  

/RJ  Remove jobs - drop all jobs from the application.  

/RP  Remove parameters - drop all parameters from the application.  

/AF  Absolute application id file name which restore point is being created for.  

If using a trusted connection, the user name and password are not necessary. 

Batch Application LOAD Options 

The following options are available on Setup Administrator to load applications. 

Option Description 

/AL  Select application load.  

/AF  Absolute application ID file name.  

/LF  Absolute log file name.  

/PF  Absolute xml parameter file name.  

/SO  Stay open - Setup Administrator does not close after the application has been created. 
Relevant for /AL LOAD option. Relevant for -QA, -QR, -WS, -QL and -QV application 
switch options. Not relevant for -QS switch option. For switch options, refer to SQL Server 
Quick Application for details.  

Setup Administrator Process Exit Codes 

When installing an application using the command line, the Setup Administrator process returns one value from a 
set of exit codes from its process when exiting. 

After an application install, when the Setup Administrator process exits, users can check the exit codes to 
determine the cause for a possible problem with the application install. 

The set of Setup Administrator exit codes are described below: 

Exit Code Name  Exit Code  Description  
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Exit Code Name  Exit Code  Description  

AdmExitedNormally 0 The user clicked the main window's X button in the top right, 
the Exit item from the File menu, or the task that ran 
completed without error. 

InternalError  1  An unexpected internal error occurred. The user should 
contact WhereScape support and supply any relevant log 
files.  

CommandCancelled  2  The user clicked the cancel button from one of the presented 
dialog boxes, thus aborting the running task.  

RequiredParameterMissing  3  One or more required parameters is missing, e.g. a name for 
the Scheduler, an ODBC DSN, a user name, a password.  

OdbcError  4  An error was reported from the RDBMS that Setup 
Administrator was communicating with.  

FileIoError  5  A specified file or directory was unable to be opened, read 
from or written to.  

ServiceControlManagerError 6 An error was reported from the Windows Service Control 
Manager. Often, this is because Setup Administrator needs to 
be run "As Admin" when dealing with the SCM.  

OracleCompilationError  7  An Oracle stored procedure has failed to compile.  

MetaDataError  8  Metadata was or was not found in the specified RDBMS, or 
the metadata failed to upgrade, or the metadata is corrupt, or 
the metadata type mismatches, i.e. trying to import an Oracle 
application into Teradata metadata.  

ItemsCheckedOut  9  In batch mode, if you want to overwrite checked out items, 
you must explicitly state so by setting the option to true in the 
settings. 

NotLicensed  10  License does not permit objects of a specific type to be 
imported.  

Users can test for these values, using a batch file and take action accordingly. 

Below is an example batch file that can be used to check Setup Administrator's exit code. 

Example batch file - SQL: 

@echo off 

  

Adm.exe /AL /AF "app_con_SQLT_base_1.wst" /LF "ImportLog.txt" /PF 

"WSL_Application_Load_SQL.xml" 

  

if errorlevel 8 goto MetaDataError  

if errorlevel 5 goto FileIoError  

if not errorlevel 0 goto ImportError  

  

echo Successfully imported  

goto end 

  

:MetaDataError  

sendmail -recipient admin@company.com -subject "Import failed" -body "Corrupt meta data found 

during application import. Re-install the Data Warehouse"  

goto end  
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:FileIoError  

sendmail -recipient admin@company.com -subject "Import failed" -body "ExportedDiagram.xml is 

missing, re-generate it then re-run this process"  

goto end  

  

:ImportError  

sendmail -recipient admin@company.com -subject "Import failed" -body "Unable to import the 

application file ExportedDiagram.xml"  

goto end  

  

:end 

Example batch file - 3D: 

@echo off 

Start /wait /D "C:\Program Files (x86)\WhereScape\Adm.exe" /AL /AF "ExportedDiagram.xml" /LF 

"C:\temp\test\ImportLog.txt" 

if %errorlevel% equ 8 goto MetaDataError 

if %errorlevel% equ 5 goto FileIoError 

if not %errorlevel% equ 0 goto ImportError 

echo Successfully imported 

goto end 

  

:MetaDataError 

sendmail -recipient admin@company.com -subject "Import failed" -body 

"Corrupt meta data found during application import. Re-install the Data Warehouse" 

goto end 

  

:FileIoError 

sendmail -recipient admin@company.com -subject "Import failed" -body 

"ExportedDiagram.xml is missing, re-generate it then re-run this process" 

goto end 

  

:ImportError 

sendmail -recipient admin@company.com -subject "Import failed" -body 

"Unable to import the application file ExportedDiagram.xml" 

goto end 

  

:end 

  

Changing the Application Directory 

1. In WhereScape's Setup Administrator, click the Application tab and then click Change Application 
Directory. 
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2. Browse and select a new application directory. 
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Listing Applications 

1. In WhereScape's Setup Administrator, click the Application tab in the left pane and then click List 
applications in Repository. 

 

2. The List applications in Repository menu option prompts for a logon to the required metadata repository. 
Applications are applied to a specific metadata repository. 
Once logged on a list of the applications that have been installed into that repository is shown. If no 
applications have been loaded, then the list is empty. An example output is as follows: 

 

This example shows that the tutorial_2 application has been loaded into the metadata. 

Testing Applications 

A testing application set consists of a Procedure and an XML script and provides the ability to define a series of 
tests against data warehouse objects; either comparing them to an expected value or to the results of a query. 

The XML script contains the test definitions. Each test is a new XML node in the XML script and contains a name, 
a test query, an expected value, or a comparison query. 

The procedure simply runs the tests and determines whether the tests are passed or not. This is most likely to be 
run as a scheduled job within WhereScape RED. 

XML Options File for Application Loads 

If applications are being loaded using the command line, the saved application load options in the local registry 
can be outputted to an XML Options File for use in the application load. 
Refer to Creating and Loading Applications from the Command Line for details. 

  

1. To create the options file, click Create XML Options File in the left pane. 
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Tip: 

 You can also access the Create XML Options File from the Applications menu.  

 

2. If the load options have not yet been saved into the local registry, a message appears prompting you to 
select the application to be loaded and to save the load settings for that application. 

o Type in the location where you want to save the XML Options File in the XML Options File Name 
field. 

o Type in the details of the XML Elements that are added to the destination details of the XML 
Options File. 

Metadata Repository Type The RDBMS type of the metadata repository. 

DSN The value to be written in the <DSN/> element of the XML Options File. 

DSN architecture The value to be written in the <DSNArchitecture> element of the 
XML Options File. 

User ID The value to be written in the <UserID/> element of the XML Options 
File. 

Password The value to be written in the <Password/> element of the XML Options 
File. 
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3. Click Create File, the results confirm that the XML Options File has been created. 
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Upgrading WhereScape RED 

WhereScape Versions 

WhereScape RED has a four part version number normally shown as xx.xx.xx.xx. An example of this may be 
8.3.1.0. The first number represents the major release. The second number represents the metadata repository 
version. The third and fourth numbers relate to application specific releases. 

From the example above, we see that the current version is version 8 of WhereScape RED. We are on version 8.3 
of the metadata repository. 

Metadata Changes 

A change from a 8.2.. release to a 8.3.. release would indicate a change in the metadata tables. All metadata 
changes are non-destructive. They simply add new columns or new meta tables. In this way they can be applied 
without harming an existing metadata repository. The impact of a metadata change is that the associated 
applications (namely the RED executable, the Scheduler, security module, etc.) needs to be at the same metadata 
version. Therefore, an 8.2.1.0 version of RED may not successfully run against a version 8.3 metadata repository. 

Application changes 

The final two numbers in the version represent application releases. Applications are deemed to be all of the 
executable images supplied with WhereScape RED as well as the UNIX scheduler scripts and the stored 
procedures. Application changes reflect enhancements and bug fixes. A change in the first number indicates a 
major enhancement in one of the application components. 

Upgrading RED 

Notes: 

• Ensure that you have made a backup your metadata before performing the upgrade. 

• Ensure you also upgrade the WhereScape RED scheduler. The old scheduler must be stopped prior to the 
upgrade and a new scheduler must be setup after RED is installed.  

 

Upgrading WhereScape RED consists of the following steps: 

1. Allow any active jobs to complete. Halting active jobs will allow running tasks to complete with no new tasks 
starting. Aborting active jobs will kill any running tasks and stop running jobs. 

2. Stop all schedulers. Windows schedulers can be stopped with WhereScape's Setup Administrator. To stop 
a UNIX or Linux scheduler, kill the active scheduler process and comment their crontab entries (to stop the 
scheduler re-starting itself). 

3. Close any WhereScape programs that are running on your machine. 
4. Back up your metadata. 
5. Install the new version of RED on your machine. 
6. In RED Setup Administrator, select the Validate Metadata Repository option. This function may re-compile 

existing or create new metadata procedures; metadata tables may be altered, or new tables created. 
7. When performing an upgrade of RED: 

o Click OK when prompted to validate metadata tables. 
o Click Yes when prompted to re-create metadata views. 
o Click Yes when prompted to re-compile metadata procedures. 

Warning 

 If the above steps are not all completed during an upgrade, the metadata may be left in an inconsistent state. 
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8. For Oracle metadata updates, see the note below on recompiling Oracle invalid procedures during a 
RED upgrade. 

9. Back up your metadata again (just in case). 
10. If using a UNIX or Linux scheduler and this is a major application enhancement, then rename the wsl/bin 

directory to say wsl/bin_versionxxxxxx. Create a new bin directory and ftp over the files under the UNIX 
directory (see the main install instructions). Change the protections on the files (chmod 750 *.sh). 

11. Restart all schedulers. Windows schedulers can be restarted with WhereScape's Setup Administrator. For 
any UNIX or Linux schedulers, uncomment any commented out crontab entries— this is enough to restart 
the schedulers. 

12. Restart any halted or aborted jobs. 

Notes: 

i. There are different versions of the scripts for each database and for UNIX versus Linux. You should also be 

looking in the sub directory with the highest version number.  When using a UNIX/Linux 
scheduler for Oracle, it is recommended that users copy the new meta_backup_680.sh file to use 
Datapump's expdb/impd instead the deprecated exp/imp tools. 

This version uses the data pump export executables expdp/impdp. It assumes that the scheduler and the 
Oracle database reside on the same server. 

ii. Metadata tables do not change between minor releases, but metadata procedure often and usually do 
change. 

iii. RED will not let you sign into an old repository version using a newer version of RED. 
iv. RED will let you sign into a new repository version using an older version of RED but it will warn you that 

this may potentially cause issues. 
v. It is very important when using the Windows scheduler to have the installed RED version on the scheduler 

server EXACTLY matching the stored procedures. 
vi. Side by side installations are possible (two versions in two directories on the same machine), but be careful 

with schedulers. If you install the new version of RED in a new directory, you must remove and reinstall all 
Windows schedulers in order for the scheduler(s) to use the new version of RED. 

vii. As a general rule, the UNIX and Linux scheduler scripts, metadata tables/procedures and RED front end 
should all be in sync. 

viii. If the scripts for the UNIX or Linux scheduler have changed, you should replace files in your old and new 
shell scripts in the WhereScape Program Files directory and see if any have changed. 

 

Oracle Invalid Procedures 

When validating an Oracle Metadata Repository, select the Recompile any invalid procedures check box to 
have any invalid user procedures recompiled during a metadata validate. 
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Checking the Unix Connection 

Note 

This section applies to Oracle data warehouses only. 

 

1. To check the UNIX connection, click the Computer Setup tab and then click Check Unix Connection. 

 

WhereScape RED can allow the user to browse a Unix file system and utilize the drag and drop 
functionality to setup the loading of files from a Unix file system. It can also perform interactive file loads. To 
facilitate this and to obviate the need to port code to every Unix environment the Telnet protocol is used for 
the Unix connectivity. 

This step is not necessary for the successful running of a Unix based data warehouse environment. As 
mentioned above it is provided to simplify the process of setting up the loading of Unix files. This step is 
totally unnecessary for a Windows based data warehouse environment. 

If you want to use these Unix drag and drop assistants, then consult the WhereScapeRED User Guide for 
an explanation of Unix connections and perform the following tasks: 

1. Identify a Unix user that allows direct logon to a Unix shell prompt without passing through a menu 
system. 

2. Ensure that the Unix user has the Oracle 'sqlldr' program in the path after a normal logon. If not, then 
interactive loads will not be possible. Scheduled loads should still function correctly. 

3. Complete the dialog box presented, specifying the Unix user and password identified in step (1). 
4. Click OK to proceed. A timeout of 20 seconds is enabled, so that if connection is not achieved within 

that time the process will terminate. The Telnet window will be displayed to assist in debugging any 
problems. It will be closed on completion or timeout. 

5. Review the results and attempt to address any problems. A file called 'WslTelnet.log' is created in 
the installation directory containing the full dialog of the connection attempt. The message 'Telnet 
connection worked. All OK' will be displayed if the connection worked. If successful record the 
parameters used as these will need to be defined when setting up a Connection within WhereScape 
RED itself. If a connection cannot be achieved, then remove all reference to a username and 
password from the file mentioned above and mail it to support@wherescape.com. 
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Testing an ODBC Source 

1. To test an ODBC source, click the Computer Setup tab and then click Test ODBC Source. 

 

2. Select the ODBC connection from the drop-down list and enter the User Name and Password. 
o Click OK. 

 

3. If the logon using the ODBC connection was successful, the following message is displayed. 
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Validating a Meta Repository 

1.  To validate a Metadata Repository, click the Metadata Repository tab and then click Validate Metadata 
Repository. 

 

This option validates the version of the meta tables installed in the specified SQL Server database, Oracle 
schema, or Teradata Database/User. If requested it goes on to validate the tables, sequences and 
procedures against the installation media. A validate can be run at any stage to confirm that all tables and 
procedures are up to date and that the procedures are in a compiled and valid state. This option can be 
used to recompile a procedure that has become invalid. This option must be used when installing a new 
version of RED and for SQL Server database to recompile all procedures. 

If a mismatch is found or a procedure is found to be invalid, the user is given the option of updating the 
metadata. If chosen, the metadata will be upgraded to the latest version. 

Note: 

Ensure the scheduler is not running and no users are accessing the metadata before doing an upgrade. 

 

Oracle Invalid Procedures 

When validating an Oracle Metadata Repository, ensure that the Recompile any invalid procedures option is 
selected to recompile any invalid user procedures during a metadata validate. 
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Validating a Metadata Repository using the Command Line 

It is possible to Validate the Metadata Repository, using the Command Line by running a batch file. 

This process can be used for all metadata database types: it validates the tables and alters or creates/copies any 
tables that require changes. 

All the process steps are logged to a file: My Documents\WhereScape\WhereScape_quick_validate.log. 

During this process: 

• All Teradata metadata views are recreated 

• Oracle sequences and procedures are validated and updated if required 

• All non-Oracle procedures are recompiled 

• All metadata indexes are recreated 

• Any Oracle non-metadata procedures that are invalid are compiled 

• Finally, the metadata version in ws_meta_tables.mt_version is updated 

To have a metadata repository validated from the command line, create a batch file using the following batch 
application quick validate options and check the example below: 

Batch Application Quick Validate options 

ADM -QV  

-SN DSN  

-SL LoginId  

-SP Password  
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-DS................................................................ 

 //SQLServer Dimension filegroup  

//Teradata – not used  

//Oracle Dimension Table Tablespace  

  

 -IS................................................................  

//SQLServer Dimension Index Filegroup  

//Teradata – not used  

//Oracle Dimension Index Tablespace  

  

  

-MS................................................................  

//SQLServer Metadata Filegroup  

//Teradata Metadata Repository Database  

//Oracle Metadata Repository Tablespace  

  

Example 

The following example validates an Oracle repository named WslWarehouse_ORA, using a connection with 
username dssdemo and password wsl. 

It recreates the Oracle Dimension Index Tablespace, validates the Oracle Metadata Repository Tablespace and 
validates/updates the Oracle Dimension Table Tablespace, recompiling any procedures that may be invalid, 
during the validate process. 

@echo off 

cd "c:\Program Files (x86)\wherescape\" 

adm -QV -SN WslWarehouse_ORA -SL dssdemo -SP wsl -IS RED_METADATA -MS RED_METADATA -DS 

RED_METADATA 

exit 
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Scheduler Installation and Configuration 
The Install Scheduler option installs and starts a copy of the WhereScape Windows scheduler. The scheduler runs 
as a system service and can also be maintained through the normal Windows services functions. 

This chapter covers both Windows and UNIX/Linux scheduler installation and maintenance. 

  

Diagram Overview of RED and Scheduler Database Access 

The following diagrams in this chapter provide an overview of how WhereScape RED and the scheduler access 
SQL Server, Oracle and Teradata and databases. 

SQL Server Diagram Overview 

The following diagram provides an overview of how WhereScape RED and the scheduler access a SQL Server 
database. 

The scheduler makes use of the ODBC layer to perform the routine tasks involved in scheduling and running jobs. 
WhereScape RED and the scheduler can also use SSIS to load data into SQL Server. 

For file or script-based loads, the scheduler actions the load on the host system using BULK INSERT. 
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Oracle Diagram Overview 

The following diagram provides an overview of how WhereScape RED and the scheduler access an Oracle 
database. 

The scheduler makes use of the ODBC layer to perform the routine tasks involved in scheduling and running jobs. 
When loading data from an ODBC source the scheduler can either use the ODBC layer or the Oracle Direct Path 
load facility. 

For file or script-based loads, the scheduler actions the load on the host system utilizing Oracle SQL* Loader. 
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Teradata Diagram Overview 

The following diagram provides an overview of how WhereScape RED and the scheduler access a Teradata 
database. 

The scheduler makes use of the ODBC layer to perform the routine tasks involved in scheduling and running jobs. 
WhereScape RED and the scheduler can also use the TPT ODBC operator to load data into Teradata. For file or 
script-based loads, the scheduler actions the load on the host system using fastload, multiload and TPT (load 
and update operators). 
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Installing a Windows Scheduler 

1. In WhereScape's Setup Administrator, click the Scheduler tab in the left pane and then click Install 
Scheduler. 
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Notes: 

• To install or maintain the Scheduler, you need to run RED's Setup Administrator as an Administrator. 

• A Windows scheduler must be run as either the system service account or as a user with administrator 
privileges in Windows. 

 

2. The Windows Scheduler Definition window appears. (The windows below show SQL Server, Oracle and 
Teradata scheduler definition examples). 

For configuration settings specific to each database, please see the field description below: 

 Example: 

 

 Example: 

Note: 

The WhereScape Windows scheduler for Oracle requires the Oracle client 11.2 or later software. The Oracle 
client software must be a close version match to the Oracle Database version—that is, the same major release 
or one release either side. 
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 Example: 

 

 

Unique Identifier 

Each scheduler requires a unique name, this unique name is the name by which the service is referenced. 

 

Possibly the database name and user, e.g. WslWarehouse_sa 
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Possibly the SID and user, e.g. ORCL_dssdemo 

 

Possibly the environment name and metadata owner, e.g. prod_dssdemo 

Scheduler Name 

When scheduling a job with WhereScape RED it is possible to assign the job to a specific scheduler. Each 
scheduler should therefore have a unique name. The default name is WIN0001. Most users change this to be the 
scheduler machine's name followed by a number, e.g.: DWHP01, where DWHP is the name of the windows 
scheduler server. 

Service Display Name 

This field displays the name that the scheduler will appear under when viewed through the Windows services. It is 
a combination of the string 'WhereScape' and the unique identifier. 

Service Logged on Under User 

This is the name of the Windows local user account that the scheduler service will use when logging on. The 
default setting is System Account, also known as the Local System service account. To set the scheduler to use a 
Windows domain user account with a password, use the Service Account option from the right-click menu. If a 
domain user account is specified then the contents of this field (on the Windows Scheduler Definition dialog) are 
ignored. 

Note: 

A domain user account requires the log on as a service privilege, in order for it to work. This is assigned 
automatically when setting the log on account, using the Services console in Windows. 

 

Work Directory 

The directory used to store some temporary files created by the scheduler. 

Tips: 

 Two schedulers must not use the same work directory. Setting Log Level 9 creates an additional detailed log file 
for each thread of each job that is run.  

Log File 

The full path for this scheduler to write a log file. The log file contains information on the scheduler service, it does 
not contain information about individual job tasks run by the scheduler. This file may become large if log level 9 is 
set. 

Poll Interval 

This defines the frequency of the scheduler polling the database, looking for work. The default is 30 seconds. If set 
to a very low interval such as 1, then the impact on the database may be noticeable. 

Log Level 

This defines the level of detail written to the log file by the scheduler service. This should be left at the default level 
unless requested by WhereScape Support. 

The following logging levels are available: 

• 0 = log no information 
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• 1 = log fatal errors only 

• 2 = log major events (default) 

• 3 = log major events and write ODBC Load statistics to the audit log in the database 

• 9 = full debug information 

Direct Path Load 

 
 

 
  

This should always be ODBC SQL load for SQL Server and Teradata schedulers. 

 

When using an Oracle repository, this option determines the method used by the 
scheduler to insert data; when using the ODBC Load type. 

ODBC SQL load: When this option is selected, the scheduler always load data using the standard ODBC driver 
method. 

Direct Path load: When this option is selected, the scheduler attempts to load data using the Oracle Direct Path 
method, via the OCI library. If it is unable to use the Direct Path method, the scheduler will revert to using the 
standard ODBC driver method. 

Direct Path loads are considerably faster and so this option should be set to Direct Path load in most situations. 

Note: 

Once a scheduler service has been created, this option cannot be changed. To change the scheduler from ODBC 
sql load to Direct Path load or vice versa, create a new scheduler service and remove the old one. 

 

TNS Service 

 
 

 
  

This is not required for SQL Server or Teradata schedulers. 

 

If you select the Direct Path load option from the Direct Path load or ODBC drop-
down-list, enter the database server as defined in the tnsnames.ora file on this 
field. Normally this will be the same name as entered for the 'server' in an ODBC 
source definition. 

ODBC Connection 

The ODBC connection field requires the ODBC source name that provides a connection to the data warehouse 
system. The scheduler uses ODBC to connect to the data warehouse. 

Database User Id 

For Windows Authentication, leave this field empty. For SQL Server Authentication, enter a database username. 
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Database Password 

 

For Windows Authentication, leave this field empty. For SQL Server Authentication, 
enter the password for the database username entered in the Database User Id field. 

 

The password for the User the Scheduler will use when connecting to the data 
warehouse database. 

 

The password or Teradata Wallet String for the User the Scheduler will use when 
connecting to the data warehouse Teradata database. 

Metadata Database (Teradata) 

 
 

 

This is not set for SQL Server/Oracle schedulers. 

 

The Database Name or User Name where the metadata repository is 
stored. This must be entered for Teradata. 

 

Note: 

A Windows scheduler must be run as either the system service account or as a user with administrator privileges 
in windows. 

 

 Error Messages: 

The following error message may appear as the scheduler starts. In such an event, the scheduler will not function 
until the problem is resolved. 

 

This error may be the result of an old version of the Oracle Call Interface (OCI) dynamic link library (dll) being in 
the path. The WhereScape scheduler requires Oracle client 11.2 or above. This situation can occur when an 
Oracle product, such as Discoverer is installed. Discoverer may install an older version of the oci.dll file. If it does, 
its location will be put in the Windows path in front of the 11.2+ client version. 

A work-around is to copy an 11.2 or later version of the oci.dll file into the WhereScape program directory. To see 
if an oci.dll is valid, right-click the file and select properties and then version. A valid oci.dll will have version 11.2 
or later. 
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Installing a UNIX/Linux Scheduler 

The Unix scheduler must be manually installed and maintained. 

The scheduler consists of a series of shell scripts that are controlled by the cron process. The bulk of the work 
undertaken by the WhereScape scheduler takes place in the WhereScape procedures within the database. To 
obviate the need to provide a port to each Unix platform this series of shell scripts are used. They should run with 
no modification on all Unix platforms and have been tested under Unix offerings from Sun, HP, IBM and Linux. 

The Unix scheduler can process every type of load except for ODBC loads, Native ODBC loads and XML loads. It 
cannot process OLAP Cubes. 

Warning: 

For UNIX/Linux scheduler processing, the Encrypt User and Password options in RED's Repository Privacy 
Settings cannot be used. Encrypt options are only supported when using a Windows scheduler. 

 

Installation 

The installation of the Unix scheduler needs to be undertaken by someone familiar with the Unix environment and 
the running of database processes from Unix. The tasks that need to be undertaken are: 

1. Unix User and Shell 

Acquire a Unix user name that has access to cron and the database data warehouse environment. A 
reasonable quantity of disk space is also required if the automated backups of the metadata repository are 
used. The user should log on to Unix without passing through a menu system if possible. Log on to the 
user. 

This user will need to have a .profile file in "/home/<user>/.profile" otherwise ws_sched_check_600.sh will 
not work. If this file doesn't exist it will need to be created. 

The WhereScape scheduler consists of several shell scripts. By default, some of these shell scripts will run 
in the Bourne shell and some will run in the Korn shell. If Linux is being used, then the Bash shell is used 
exclusively. 

Note: 

During setup, it is recommended that the Korn shell be used as the default shell for the user installing the 
scheduler (or Bash if running Linux). 

 

2. Create directories 

Create the following directories (if not already present) to be used by the WhereScape scheduler. 

If the directory names are not appropriate and others must be used, then it will be necessary to alter the 
WhereScape supplied scripts. 

o  wsl (top level directory for WhereScape directories)  

o  wsl/bin (used to store the WhereScape scripts)  

o  wsl/sched (used for the scheduler job and log files)  

o  wsl/sched/job (used for the scheduler job files)  

o  wsl/sched/joblog (used for the scheduler job logs)  

o  wsl/sched/log (used for the scheduler logs)  

o  wsl/export (used for the automated exports of the metadata)  

o  wsl/expback (used to hold compressed copies of the metadata exports)  

o  wsl/log (used for export and archive logs)  

  

 Oracle only directories 
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o wsl/mon (used for the monitoring process) 

o wsl/mon/db (used for database monitoring scripts and control files) 

o wsl/mon/job (used for job monitoring scripts) 

o wsl/mon/log (used for monitoring log files) 

3. Copy supplied Unix files  
FTP the scheduler files shipped with WhereScape RED to the wsl/bin directory on the Unix system (use 
ASCII mode). All files must be copied over. WhereScape RED ships with several different versions of the 
Unix files for the scheduler. The appropriate version of the files must be copied to the server. The following 
lists the files shipped:  

 

o  ...\WhereScape\Oracle\Unix\Version_nnn\...  

o  ...\WhereScape\Oracle\Linux\Version_nnn\...  

 

o ...\WhereScape\Teradata\Unix\Version_nnn\... 

o ...\WhereScape\Teradata\Linux\Version_nnn\... 

Notes: 

There may be several different versions of the scheduler files for a given database and platform (Unix or Linux). 
These are identified by version numbers nnn. For example, there may be three different folders in: 

 ...\WhereScape\Oracle\Linux\: Version_010, Version_410 and Version_560. 

 ...\WhereScape\Teradata\Linux\: Version_560 and Version_600.  

The highest version number script less than or equal to the version of RED in use should always be used.  

In the table that follows, the nnn in file names refers to the version number of the script. Some scripts will have 
010, some will have 411, others 560 or 680, etc.  

 

A definition of the files follows: 

File Purpose 

oraenv (for Oracle) 

tdenv (for Teradata)  

Contains the template of a script for setting environmental variables. This needs to 
reside in the home directory of the Unix user and must be tailored for the database user 
and environment. It may be renamed to reflect the actual environment.  

• e.g. oraenv_SID_user for Oracle  

• e.g. tdenv_TDPID_user for Teradata  

crontab Contains the template of the required cron commands. This file needs to be modified to 
include the HOME directory of the Unix user, and the name of the environment file. It is 
then used to update the crontab tables. 

ws_start_nnn.sh  Script to start the scheduler. This script is normally called by the 
ws_sched_check_nnn.sh script and is passed the database environment file name as a 
parameter. 

ws_sched_check_nn
n.sh 

Script to check that the scheduler is running. This script is normally executed by cron 
every 20 minutes. If the scheduler is found to be absent it attempts to start a new 
iteration. By default, the scheduler will terminate if its database is shut down. This script 
will therefore start the scheduler after a system start-up or a database start-up. 

ws_sched_nnn.sh The actual scheduler script. This script looks for new scheduler jobs every x seconds. 
The default is every 30 seconds. This script must be modified to change the default 
behavior. It calls the ws_job_wait_010.sh script to perform the actual checking and 
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File Purpose 

initiating of a job. It terminates when ws_job_wait_010.sh returns an error and relies 
upon cron for a restart. 

ws_sched_status_nn
n.sh 

This script is called by ws_sched_nnn.sh to update the scheduler status in the scheduler 
metadata. It's a wrapper of the metadata database procedure ws_sched_status (i.e. it 
calls the database procedure ws_sched_status and returns its results to the calling 
script). 

ws_job_wait_nnn.sh This script performs the bulk of the work. It is called by ws_sched_nnn.sh on a regular 
basis. It checks for any job waiting to run. If it locates a job that is ready to run it will 
create and start a script in the $HOME/wsl/sched/job directory for each thread of that job. 
These job threads in turn perform the actual processing and log their results to 
$HOME/wsl/sched/joblog. Under normal operation it is not necessary to check or inspect 
these files. 

ws_job_check_nnn.s
h 

This script is called to check the status of running jobs. It is called by ws_sched_nnn.sh 
on a regular basis (the interval is defined in ws_sched_nnn.sh). It checks that any job 
running in the scheduler is actually running in the Unix environment. If a job is not found 
under Unix, then it is aborted in the scheduler. This scenario can occur as the result of a 
database or machine crash. If a job abort is required, the results are logged to 
$HOME/wsl/sched/log/job_check_'env file name'.log. Under normal operation it is not 
necessary to check or inspect this file. 

cleanup_nnn.sh This script is normally executed by cron and cleans up files created by the WhereScape 
scheduler. It deletes old versions of the jobs, job logs, and backups. It will also delete 
any temporary scripts created in the running of host scripts or file loads from within the 
scheduler. The location of these temporary scripts is defined within the WhereScape 
RED Unix Connection object. The default value in the cleanup script is /tmp and this 
must be altered if a different temporary directory is used for a Connection. 

 
 Oracle only files 

meta_backup_nnn.sh This script is normally called by the cron process once or maybe more times a day to 
perform an automated export backup of the metadata tables. It creates a number of 
command files and a database export in the $HOME/wsl/export directory named with the 

date/time of the export.  It is recommended that users copy the new 
meta_backup_680.sh file to use Datapump's expdb instead the deprecated exp tool. 
This version uses the data pump export executable expdp. It assumes that the scheduler 
and the Oracle database reside on the same server. 

meta_archive_nnn.sh This script is normally called by cron once a day to compress and tar the files in the 
$HOME/wsl/export directory and relocate them to the $HOME/wsl/expback directory. 
This action is performed purely to save on disk space usage. 

meta_restore_nnn.sh This script can be executed to restore from a meta repository backup. It will overwrite 
any existing metadata. It can be used to restore to a schema/database/user other than 
the one from which the backup was taken. It does not however restore the WhereScape 
procedures. If a full recovery or a new user create is required, then the WhereScape 
metadata install would normally be performed before actioning this restore. If the restore 
is from an export that has been moved to the expback directory, you will need to 
uncompress the export and move it and associated files back to the export 

directory.  It is recommended that users copy the new 
meta_restore_680.sh file to use Datapump's impd instead the deprecated imp tool. This 
version uses the data pump import executable impdp. 

It assumes that the scheduler and the Oracle database reside on the same server. 
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File Purpose 

 
 Oracle only files 

ws_mon_nnn.sh The main monitoring script. This script in turn calls the database and job monitoring 
scripts to perform the monitoring. By default, the monitor process checks the jobs every 
15 minutes and the database every 60 minutes. This script can be edited to change the 
frequency of the checks if required. Also, a log level of 9 can be set to produce debug 
logging. 

ws_mon_db_nnn.sh This script checks the database status and if necessary, calls the notify script to notify of 
a database down. Also checks to see if the criteria for database monitoring has changed 
and if changed calls the refresh script. 

ws_mon_notify_nnn.
sh 

This script checks that notifications are valid for the day/time and if valid sends a 
notification. 

ws_mon_refresh_nnn
.sh 

This script refreshes the scripts and command files stored in the mon/db directory. These 
scripts and command files are used to ascertain the action should the database be 
unavailable. 

ws_mon_jobs_nnn.sh This script performs the checking of jobs for which monitoring is defined. If a job has a 
notification required, then this script will issue the notification. 

ws_mon_start_nnn.s
h 

This script starts the monitor process. 

ws_mon_check_nnn.
sh 

This script checks that the monitor process is running. If not running, the script will start 
the monitor process. This script is normally called via cron every 30 minutes. 

4. Set permissions: 

Change the permissions on the copied scripts so that they are executable (e.g. chmod 750 
$HOME/wsl/bin/*.sh). 

5.  Create an environment file (see below for relevant Oracle or Teradata environment file instructions). 

 Using the environment file (oraenv) as a template and adhering to the variable names 
within, create an environment file for the database environment and user under which the scheduler is to 
run. 

This file should be located in the $HOME directory. It may be called anything, but a meaningful name may 
be oraenv_SID_user for a given Oracle scheduler. 

Check the users .profile and database environment file to see the normal settings. For Oracle, check to see 
if the TNS_ADMIN variable is in use and if so, include it in the environment file. 

Make the following replacements in the environment file:  

o  Replace all occurrences of _HOME_ with the full pathname of your home directory.  

o  Replace _USER_ with the data warehouse database user name.  

o  Replace _PASSWORD_ with the data warehouse database user password.  

o  Replace all occurrences of _SID_ with the SID of the data warehouse database.  

o  Replace all occurrences of _ORAHOME_ with the full pathname of the Oracle home directory.  

 Using the environment file (tdenv) as a template and adhering to the variable names 
within, create an environment file for the database environment and user under which the scheduler is to 
run. 

The environment file must be copied to the $HOME directory of the user selected in Step (1). It may be 
called anything, but a meaningful name may be tdenv_TDPID_user for a given Teradata scheduler. 

Check the users .profile and database environment file to see the normal settings. 
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o  Replace all occurrences of _HOME_ with the full pathname of your home directory.  

o  Replace all occurrences of _TDPID_ with the host name of the data warehouse database server, 
used by the scheduler as the database server name for Teradata load and unload utilities.  

o  Replace all occurrences of _BTEQDB_ with the host name or IP address of the data warehouse 
database server, used by the scheduler as the database server name/address for reading and 
writing WhereScape RED Metadata in Teradata (may be set to the same value as _TDPID_).  

o  Replace _USER_ with the data warehouse database user name.  

o  Replace _PASSWORD_ with the data warehouse database user password.  

o  If using a Teradata Wallet String, comment out the first Password line and comment back in the 
second line containing _WALLETSTRING_. Replace all occurrences of _WALLETSTRING_ with the 
data warehouse user wallet string.  

o Replace all occurrences of _METABASE_ with the user or database where the metadata resides 

o Replace all occurrences of _WORKDIR_ with the name of the directory that will be used as the work 
directory by default (e.g. /tmp/ ) 

6. Setup crontab 

Ascertain if there are any existing crontab entries, and if so save them to a file for re-inclusion later. (e.g. 
crontab –l crontab –l >/tmp/my_crontab ). 

Edit the crontab file and perform the following changes. Also check all entries and make sure you are happy 
with the times and actions: 

o  Change all occurrences of _HOME_ with the full pathname of the Unix users home directory.  

o  Change all occurrences of the environment file name (oraenv or tdenv) to the name of the file 
created in step (4).  

o  Remove comment markers from the beginning of the second line of code (the line containing this: 
ws_sched_check_nnn.sh).  

o  Include any existing crontab entries as recorded above.  

7. Initialize crontab entries 

o  Load the crontab file into cron (e.g. crontab crontab ).  

o  Perform a crontab list to ensure it all looks OK (e.g. crontab –l ).  

8. Start Scheduler 

Manually start the scheduler by issuing the ws_sched_check_nnn.sh script with the environment file name 
from step (4) as the parameter (e.g. ws_sched_check_010.sh oraenv ) / (e.g. ws_sched_check_600.sh 
tdenv ) / . 

If the scheduler is not running it will be started. Execute the script a few more times to ensure that only one 
copy of the scheduler is started. Check that the scheduler is running by executing a 'ps –ef' statement and 
checking that the ws_sched_nnn.sh process is present. 

9. Start the Monitor process 

 Oracle only. 

Manually start the monitor by issuing the ws_mon_check_010.sh script with the environment file name from 
step (4) as the parameter (e.g. ws_mon_check_010.sh oraenv ). If the monitor is not running it will be 
started. Execute the script a few more times to ensure that only one copy of the scheduler is started. Check 
that the monitor is running by executing a 'ps –ef' statement and checking that the ws_mon_010.sh process 
is present. 

10. Test the Scheduler 

Run a job from WhereScape RED and ensure that it works. In the event of the job not starting or going into 
and remaining in a pending state, then the following investigations should be undertaken:  

o Ensure all WhereScape procedures are compiled. Use the Validate metadata option in the Setup 
Administrator to confirm that all procedures are valid.  
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o Review the job logs in $HOME/wsl/sched/joblog.  

o Review the logs in $HOME/wsl/sched/log.  

o Isolate the name of the job and locate the relevant files for this job in $HOME/wsl/sched/job and 
$HOME/wsl/sched/joblog if they exist. Mail these files together with the files in $HOME/wsl/sched/log 
to support@WhereScape.com. It may be necessary to remove password references from the file(s) 
in $HOME/wsl/sched/job.  

Note: 

It is possible to stop a Linux/UNIX Scheduler from within WhereScape RED. Refer to the WhereScapeRED User 
Guide or See the Teradata WhereScapeRED User Guide for further details. 

 

Unix Scheduler setup for Hadoop loads using Oracle's Big Data Connectors 

To set up the UNIX scheduler for Oracle loads from Hadoop using Oracle's Big Data connectors with OSCH and 
OLH, the following environment variables need to be edited in oraenv: 

Example 

export JAVA_HOME=/usr/lib/jvm/java-openjdk 
export HADOOP_HOME=/home/oracle/hadoop-2.4.1 

export PATH=$ORACLE_HOME/bin:$HADOOP_HOME/bin:$PATH 
export JAVA_LIBRARY_PATH=$HADOOP_HOME/lib/native:$JAVA_LIBRARY_PATH 

export HADOOP_COMMON_LIB_NATIVE_DIR=$HADOOP_HOME/lib/native 
export HADOOP_OPTS="$HADOOP_OPTS -Djava.library.path=$HADOOP_HOME/lib/native" 

For either OSCH or OLH, add one of the following to oraenv: 

#OSCH 
export OSCH_HOME=/home/oracle/orahdfs-3.1.0 
export PATH=$OSCH_HOME/bin:$PATH 
export HADOOP_CLASSPATH=$OSCH_HOME/jlib/*:$HADOOP_CLASSPATH 

#OLH 
export OLH_HOME=/home/oracle/oraloader-3.2.0-h2 
export HADOOP_CLASSPATH=$OLH_HOME/jlib/*:$HADOOP_CLASSPATH 

Notes: 

Please restart the scheduler after you modified environment variables in oraenv. 

The following Oracle directory objects need to be created with certain privileges: 

OSCH 

OSCH directory objects 
OSCH bin Directory 
OSCH External Tables Directory 
OSCH Log Directory 

Example  

CREATE DIRECTORY osch_bin_path AS '/opt/orahdfs-3.1.0/bin'; 
GRANT EXECUTE ON DIRECTORY osch_bin_path TO c##oschuser; 
GRANT READ ON DIRECTORY osch_bin_path TO c##oschuser; 
CREATE DIRECTORY exttab_default_directory AS '/home/oracle/exttab'; 
GRANT READ ON DIRECTORY exttab_default_directory TO c##oschuser; 
GRANT WRITE ON DIRECTORY exttab_default_directory TO c##oschuser; 
CREATE DIRECTORY osch_log_path AS '/home/oracle/temp' 
GRANT READ ON DIRECTORY osch_log_path TO c##oschuser; 
GRANT WRITE ON DIRECTORY osch_log_path TO c##oschuser; 

 



WhereScape® RED Installation Manual 

  

© Copyright, WhereScape, Inc. All rights reserved. - 112 - 

Maintaining the Windows Scheduler 

1. To maintain the Windows scheduler, click the Scheduler tab and then click Scheduler Maintenance. 

 

2. This option lists all currently active WhereScape schedulers. 

 Right-click a scheduler name to display a context menu as follows: 

 

The options are: 

Option Description 

Configure Enables the alteration of the service configuration. You can change the level of logging. 
The default is 2. Level 0 provides no log information and level 9 provides full debug. See 
Scheduler Creation for more detail.  

Start Starts a stopped scheduler. This action requires service control manager (SCM) 
privileges on the PC. 

Stop Stop a running scheduler. SCM privilege required. 

Remove Removes and deletes the scheduler. SCM required. 

Service Account By default, the scheduler will start in the system account. If you wish to change this, you 
can specify an account and password. However, you may have to remove the service 
and enter the account information when creating a new scheduler. 

Manual Startup Changes the startup profile (on PC startup) of the scheduler. The scheduler will not be 
automatically started when the PC starts and must be started manually. SCM required. 

Automatic Startup Sets the scheduler to start automatically when the PC starts. SCM required. 

Disabled Startup Sets the scheduler startup profile to disabled. No startup will occur unless the profile is 
changed to either Manual or Automatic. SCM required. 
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Option Description 

View Logfile Displays the scheduler service log file. The level of logging is defined in the configuration 
of the scheduler. 

  

Notes: 

If an error occurs while a scheduled job is running, you should check the following: 

•  the audit log of the failed task, for any messages of type E or F.  

•  the audit log of the failed job, for any messages of type E or F.  

•  the scheduler log file for any error messages.  

•  the windows event logs, specifically the Application and System event logs, for any Error or Warning 
messages at the time of the job failure.  

 How to view and manage event logs depends on which version of Windows you are using. If you need further 
assistance, please contact support at support@wherescape.com.  
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BDA 

Overview 

WhereScape Big Data Adapter (BDA) is designed as an adapter to RED, focused on executing ELT related 
processing within the Hadoop/Hive eco-system. 

This chapter attempts to guide users through the initial BDA setup, providing an overview of BDA, the 
prerequisites to operate it, step-by-step instructions to setup BDA. The setup of required connections and BDA 
operations is described in the WhereScape RED User Guide. 

BDA is a java application and runs as a Tomcat webapp, with REST endpoints. BDA is simple to install, users only 
need to install RED, copy and extract the bda.tar.gz file from the Linux folder in RED's installation directory into the 
Linux system and execute the script. Before running the script, there are also other configuration settings that will 
need to be completed. 

Prerequisites 

To operate BDA, users must have the following prerequisites: 

RED Environment 

• Matching RED version 

• bda.tar.gz file 

• 32-bit or 64-bit Hive ODBC Driver (this is only required for accessing Hive tables) 

BDA Environment 

• Database specific JDBC drivers (Refer to Adding JDBC drivers for more details about the specific JDBC 
drivers required for each database type) 

• Hadoop 2.7.1 

• Sqoop 1.4.5 

• Hive 1.1.0 

• OpenSSL available on the Linux scheduler machine 

BDA Diagram Overview 

This diagram displays the operations performed by BDA and RED to integrate with Hive and Hadoop sources and 
using Sqoop to load to and from Target Databases. 
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How to set up BDA 

Step-by-step instructions to set up BDA 

Below is a sample step by step instruction on how to set up BDA, please note that you may have or you may 
choose to have different settings than the ones on the examples below. 

1. From your WhereScape RED directory, go to the Linux folder and copy the bda.tar.gz file into your Linux 
system. 

2. In your Linux system, create a folder to install BDA, in this example we are installing it the $HOME/bda 
folder. 

3. Unzip the bda.tar.gz file to $HOME/bda folder. 

4. Copy $HOME/bda/conf/bdaenv to $HOME and edit it according to your environment. In the example below, 
the file is configured for a SQL Server environment. 
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5. Copy any required JDBC driver JARs into bda/lib. 

6. Start BDA by running: 

$HOME/bda/bin/ws_bda.sh start bdaenv 

7. To Start BDA run: 

$HOME/bda/bin/ws_bda.sh stop bdaenv 

8. To change configuration: 

Edit $HOME/bdaenv  



WhereScape® RED Installation Manual 

  

© Copyright, WhereScape, Inc. All rights reserved. - 118 - 

Run $HOME/bda/bin/ws_bda.sh restart bdaenv  

9. To upgrade BD: 

Stop BDA 

Copy the new bda.tar.gz file to the Linux system and extract it to $HOME/bda folder 

Start BDA 

Sample BDA Setup 

 

Adding JDBC Drivers 

To add JDBC drivers: 

1. Download the required JDBC driver for your specific database type: 

o ojdbc7.jar for Oracle databases 

o sqljdbc4.jar for SQL Server databases 

o terajdbc4.jar and tdgssconfig.jar for Teradata databases 

2. Add the required JDBC driver jar files to the relevant lib folders, such as $HOME/bda/lib or sqoop/lib . 

Example: 
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To load from either SQL, Oracle or Teradata, download the relevant JDBC driver(s) and copy the jar files to the 
bda/lib directory and Sqoop's lib directory. 

On the Hortonworks sandbox and Cloudera quickstart virtual machines the sqoop library directory is 
/usr/lib/sqoop/lib . 

Testing the BDA Setup 

To test the BDA setup: 

• Type the bda URL in your browser, for example: http://192.168.60.201:8080/bda/rest/v1/admin/version. 

o The test will confirm that BDA is installed and configured correctly if the message displayed on the 
browser is your BDA version. 

 

Note: 

This doesn't display properly when using Internet Explorer®.  

Microsoft® Edge, Google Chrome™ or Mozilla® Firefox® all display this correctly. 

 

After completing the Hive connection setup described in the Hive connection topics in the RED, you 
can test the BDA connection from RED. 

If the BDA server(s) are properly set up in RED, you can see the BDA Server versions configured in 
Hive connection objects by clicking in Help > About WhereScape RED. 

If there are any messages displayed in this window, please refer to Troubleshooting for details. 
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Important: 

A Hive connection must exist before BDA settings (Connection > Properties > Big Data Adapter 
Settings) appear in other database connections.  

 

Configuring Kerberos for a secure use with BDA 

To configure Kerberos for use with BDA, users need to do the following configuration steps: 

1. Download the Kerberos Windows client (http://web.mit.edu/kerberos/dist/) and configure it using the 
Kerberos KDC. 

Tip: 

 If necessary, manual changes for a Kerberos configuration in Windows can be made in the configuration file 
C:\ProgramData\MIT\Kerberos5\krb5.ini. In some installations where this file is not found, please add the 
system variable KRB5_CONFIG=C:\ProgramData\MIT\Kerberos5\krb5.ini.  

2. Check your KRB5CCNAME environment variable; for example, C:\temp\krb5cache. 

 

 

http://web.mit.edu/kerberos/dist/
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Notes: 

• krb5cache is a regular file (not a directory) managed by the Kerberos software and should not be created 
by the user.  

• If you change this variable, you will need to restart your computer to ensure MIT Kerberos for Windows 
uses this setting.  

 

3. Cloudera Hive Configuration Example. 

Note: 

The following example is based on Cloudera Hive with impersonation enabled. Please refer to the vendor 
documentation for your Hive distribution to configure Kerberos in your environment. 

 

Configure your Hive ODBC connection by downloading a Hive ODBC client, e.g. HortonWorks or Cloudera, 
and configure it to use Kerberos authentication as shown in the example below. 
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4. In RED, update your JDBC connection string for your relevant connections. 

The JDBC connection string for WhereScape RED connections to a Hive database needs to be updated to 
reflect the secured server where the principal in the connection string must be the HiveServer2-Kerberos-
Principal: 

example:  

jdbc:hive2://quickstart.cloudera:10000/default;principal=hive/quickstart.cloudera@CLOUDERA; 

5. BDA then needs to be changed to connect to a Kerberos secured environment. The configuration 
parameters are the following options included in the bdaenv file: 
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########################################  

# Kerberos Authentication  

########################################  

 # Example configuration for a Kerberos-secured cluster  

# WS_BDA_HADOOP_SECURITY_AUTHENTICATION=kerberos  

# WS_BDA_HADOOP_SECURITY_PRINCIPAL=hive/quickstart.cloudera@CLOUDERA  

# WS_BDA_HADOOP_SECURITY_KEYTAB=/etc/hive/conf/hive.keytab  

6. Depending on the cluster configuration, there are two options with and without proxy users enabled. 

The proxy option is the preferred option because this enables BDA to use any valid Kerberos principal 
instead of the hive super-user, in general hive/quickstart.cloudera@CLOUDERA. A sample configuration 
using a user defined principal is as follows: 

WS_BDA_HADOOP_SECURITY_AUTHENTICATION =kerberos 
WS_BDA_HADOOP_SECURITY_PRINCIPAL =bda@CLOUDERA 
WS_BDA_HADOOP_SECURITY_KEYTAB =/home/bda/bda.keytab 

If you need to access a cluster without proxy users enabled, you can use following configuration: 

WS_BDA_HADOOP_SECURITY_AUTHENTICATION =kerberos 
WS_BDA_HADOOP_SECURITY_PRINCIPAL =hive/quickstart.cloudera@CLOUDERA 
WS_BDA_HADOOP_SECURITY_KEYTAB =/etc/hive/conf/hive.keytab 

Note: 

 The last option for the keytab file assumes that the file /etc/hive/conf/hive.keytab exists and is readable for the 
user running the Tomcat service. In a Cloudera cluster using Cloudera Manager, keytab files are generated and 
stored in several local directories. One way to find the keytab file is to use the find command on the command 
shell: find / -name hive.keytab -print  

and copy the corresponding file to the destination folder. Also, you will need to repeat this step after each 
password change of the principal "hive" in the Cloudera Manager.  

 

Hadoop on a UNIX shell 

For browsing Hadoop HDFS and loading data from Hadoop HDFS, WhereScape RED establishes a connection to 
the Linux server via a secure shell. Although some ssh-clients allow ticket forwarding for Kerberos this option is 
not available for PuTTy psexec. The easiest method is to create a keytab file that is readable only for the session 
user and to add the kinit command to obtain a Kerberos ticket at log-on time. 

e.g.: add "kinit cloudera@CLOUDERA -k -t ~/cloudera.keytab" to 

/home/cloudera/.bashrc. 

Secured Hadoop and Scheduler 

Apart from ODBC loads into Hive tables, all Kerberos authentications are performed on the Hadoop server side 
and, therefore, are independent of the invocation method, interactive or scheduler. 

For ODBC loads, the service user running the scheduler needs to provide a valid ticket for a Kerberos principal. 
Because the ticket must be renewed automatically, a keytab file for this user needs to be provided on the server 
running the WhereScape RED scheduler. For instance, the Dos-shell command "kinit" can be run periodically as a 
Windows scheduled task to renew a ticket without user interaction: 

e.g.: kinit -k -t C:\Users\ServiceUser\cloudera.keytab cloudera@CLOUDERA 

Note: 

The keytab file should be readable to the service user only. 
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Troubleshooting 

BDA 

If there are any issues with your setup, you can look into the log files. 

• To check if BDA is working, enter the following URL on your browser:  

http://192.168.60.201:8080/bda/rest/v1/admin/version or log in to RED and check the Help > About 
WhereScape RED > BDA Server(s). 

For some failed operations, the output in RED contains error messages. If you experience any further issues, 
please check if each of the components are working by executing the following commands below on the Linux 
server: 

Hadoop 

To check if HDFS is running, run the following command line on the Linux server. 

wsldemo@suse-bda-1:~/bda> hdfs dfs -ls /user 

Hive 

To check if you can connect to Hive, run the following command line on the Linux server. Use the same JDBC 
connection string that has been defined in your Hive connection. 

wsldemo@suse-bda-1:~/bda> beeline 

Beeline version 1.2.1 by Apache Hive 

beeline> !connect jdbc:hive2://localhost:10000 

Connecting to jdbc:hive2://localhost:10000 

Enter username for jdbc:hive2://localhost:10000: wsldemo 

Enter password for jdbc:hive2://localhost:10000: ******** 

Sqoop 

Using the following sqoop command line tool, you can test if sqoop is working. Use the same JDBC connection 
string that has been defined in your connection. 

wsldemo@suse-bda-1:~/bda> sqoop eval --connect 

'jdbc:teradata://192.168.60.100/DATABASE=wslrepo,DBS_PORT=1025' --driver 

'com.teradata.jdbc.TeraDriver' --username 'wsldemo' --password 'password' --query 'SELECT 1' 
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Languages 
The Languages component of WhereScape's Setup Administrator enables you to create a Language file or to 
load a Language File into RED. 

1. Click on the Languages menu item in the command bar at the top of the screen. 
o Click any of the options under this level to action them. The Languages menu is as follows: 

 

o The Load Languages - option lists the Language files that have been created. A file can be selected 
and loaded into the target Metadata Repository. Refer to Loading Languages for details. 

o The Create Language File - option enables you to create a Language file for a particular Metadata 
Repository. A translator is needed to replace the English definitions in the file with the translations 
relevant to the chosen language. Refer to Creating a Language File for details. 

o The Change Languages Directory - option enables you to change the language directory. Refer to 
Changing the Languages Directory for details. 

Loading Languages 

Note: 

Before you install a language, you first need to logon to the repository in RED; go to Tools/Language Options 
and add the language. 

 

1. Click the Languages menu at the top of the screen, then choose Load Languages. 

 

2. The Load Languages menu option lists the Language Files available. 

o Right-click a particular file and select Install Language. 

 

You are then be prompted to logon to the required metadata repository and to select the Language 
to be updated in RED. 

The results are shown in the middle pane. 

Creating a Language File 

To create a language file: 

1. Click the Languages menu at the top of the screen. 

o Select the Create Language File option. 
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2. You are prompted to logon to the required metadata repository. Language Files are applied to a specific 
metadata repository. 

Once logged on, you are prompted for: 

o  The Language - select from the drop-down list. Select a Language or choose Original to create a 
Language file containing the original values.  

o  The entries to exclude from the extract.  

o  The file delimiter, translation prefix and translation format.  

o  The file delimiter provides an easy means of breaking up the file after extract.  

o  The translation prefix must be something that will NEVER appear in the data itself. This is used to 
identify the start/end of any given field translation.  
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A Language extraction file is then created and saved into C:\ProgramData\RED\Language\. 

A translator is need to replace the English definitions in the file with the translations relevant to the 
chosen language. 

Changing the Languages Directory 

To change the languages directory: 

1. Click on the Languages menu item in the command bar at the top of the screen and select Change 
Languages Directory. 

 

2. Browse and select a new languages directory. 
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Tools 

Start/Stop logging 

In WhereScape Administrator, users have the option of logging all output to a file by selecting the Start logging 
function in the Tools menu. 

1. To starting logging output from WhereScape Administrator, click on Tools > Start logging in the top bar. 

 

2. When this option is selected, users are prompted to create a file in a specified location. Once this is done, 
all the output from WhereScape Administrator starts getting logged to that file. 

 

3. To cancel logging, click Tools > Stop logging. 
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RED Command Line Interface 
WhereScape RED provides command line interface applications that you can use to perform different tasks or 
execute functions and operations outside the RED GUI. 

• RED Client Command Line 

• RED Setup Administrator Command Line 

  

RED Setup Administrator Command Line (adm.exe) 

The RED Setup Administrator command line interface enables you to execute commands to : 

• Quickly deploy a WhereScape RED application to create and populate a data warehouse 

• Quickly create a RED repository with the required metadata tables 

• Quickly load a file that contains language data into RED 

• Quickly validate a RED repository and its metadata tables 

• Quickly connect to a tutorial database to use in RED 

• Install and configure a Windows scheduler for RED 

• Deploy a RED application  

The following is a sample Windows Command Prompt that displays the help for RED Setup Administrator 
(adm.exe) arguments. 
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RED Setup Administrator Command Line Arguments 

The following describe the command line arguments that can be used in RED Setup Administrator (adm.exe). 

Description Argument long name Argument short name 

Display the RED arguments. 
 
Note: No other arguments required. 

--help   -h or /h 

Quick start 
 
Note: No other arguments required. 

--quick-start -QS or /QS 

Quick application 
 
Note: Must have other arguments, 
refer to Quick Application..  

--quick-app -QA or /QA 

Quick repository 
 
Note: Must have other arguments, 
refer to Quick Repository.   

--quick-repo  -QR or /QR 

Quick language 
 
Note: Must have other arguments, 
refer to Quick Language.   

--quick-lang  -QL or /QL 

Quick validate 
 
Note: Must have other arguments, 
refer to Quick Validate. 

--quick-validate -QV or /QV  

Quick tutorial 
 
Note: Must have other arguments, 
refer to Quick Tutorial. 

--quick-tutorial -QT or /QT 

Windows scheduler  
 
Note: Must have other arguments, 
refer to Windows Scheduler.  

--win-scheduler -WS or /WS 

Deploy application 
 
Note: Must have other arguments, 
refer to Deploy Application.   

--deploy-app -AL or /AL 

Stay open 
 
Notes:  

• Use to make Setup 
Administrator remain open, 
after the application has been 
created. 

• Relevant for -AL LOAD 
option. 

•  Relevant for -QA, -QR, -WS, 
-QL and -QV application 
switch options.  

--stay-open -SO or /SO 
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Note: 

When --quick-start (-QS or /QS) is specified, then no other parameters are required. 

 

  

The succeeding sections outline how the arguments are used. 

  

Quick Application 

The following describe the relevant command line arguments for quick application (--quick-app or -QA):  

Description Argument long name Argument short name 

Instance name  --instance-name <name>  -SS <name> or /SS <name> 

New repository name  --meta-dsn <name>  -SN <name> or /SN <name> 

Database login name  --meta-user-name <name>  -SL <name> or /SL <name> 

Database password   --meta-password <password> -SP <password> or /SP <password> 

Application ID file name  --app-id-file-name <name> -AN <file name> or /AN <name>  

Application file's directory --app-dir <path name>  -AD <directory name> or /AD 
<name> 

Application load instance  --app-instance <name>  -LI <name> or /LI <name> 

Application trusted flag  --app-trusted  -LT or /LT 

Application ODBC DSN  --app-meta-dsn <name> -LD <name> or /LD <name> 

ODBC DSN architecture  --meta-dsn-arch <32|64> -a <32|64> or /a <32|64> 

Application load database  --app-db-name <name>  -LN <name> or /LN <name> 

Application job name  --app-job-name <name> -JN <name> or /JN <name> 

Datawarehouse connection name  --dw-con-name <name>  -DC <name> or /DC <name> 

MSAS cube connection name  --msas-con-name <name>  -CC <name> or /CC <name> 

MSAS cube database name  --msas-db-name <name>  -CD <name> or /CD <name> 

Scheduler login name  --sched-login-name <name>  -ML <name> or /ML <name> 

Scheduler password  --sched-password <password>  -MP <password> or /MP 
<password> 

  

Note: 

Refer to SQL Server Quick Application for details. 

 

  

Quick Repository 

The following describe the relevant command line arguments for quick repository (--quick-repo or -QR):  

Description Argument long name Argument short name 

ODBC DSN  --meta-dsn <name> -SN <name> or /SN <name> 

ODBC DSN architecture  --meta-dsn-arch <32|64> -a <32|64> or /a <32|64> 

ODBC login name  --meta-user-name <name>  -SL <name> or /SL <name> 

ODBC password --meta-password <password>  -SP <password> or /SP 
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Description Argument long name Argument short name 

<password>  

TDPID  --tdpid <id> -DI <name> or /DI <name> 

Dimension tablespace   --dim-space <name> -DS <name> or /DS <name> 

Index tablespace   --index-space <name> -IS <name> or /IS <name> 

Metadata tablespace  --meta-space <name>  -MS <name> or /MS <name> 

  

Note: 

Refer to SQL Server Quick Application for details. 

 

  

Quick Language 

The following describe the relevant command line arguments for quick language (--quick-lang or -QL):  

Description Argument long name Argument short name 

ODBC DSN  --meta-dsn <name> -SN <name> or /SN <name> 

ODBC DSN architecture  --meta-dsn-arch <32|64> -a <32|64> or /a <32|64> 

ODBC login name  --meta-user-name <name>  -SL <name> or /SL <name> 

ODBC password --meta-password <password>  -SP <password> or /SP 
<password>  

Language file  --lang-file-name <name> -LF <path name> or /LF <path 
name> 

Add language if absent  --add-lang  -Add or /ADD 

  

Note: 

Refer to Languages for details. 

 

  

  

Quick Validate 

The following describe the relevant command line arguments for quick validate (--quick-validate or -QV):  

Description Argument long name Argument short name 

ODBC DSN  --meta-dsn <name> -SN <name> or /SN <name> 

ODBC DSN architecture  --meta-dsn-arch <32|64> -a <32|64> or /a <32|64> 

ODBC login name  --meta-user-name <name>  -SL <name> or /SL <name> 

ODBC password --meta-password <password>  -SP <password> or /SP 
<password>  

Dimension tablespace   --dim-space <name> -DS <name> or /DS <name> 

Index tablespace   --index-space <name> -IS <name> or /IS <name> 

Metadata tablespace  --meta-space <name>  -MS <name> or /MS <name> 
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Note: 

Refer to Validating a Metadata Repository using the Command Line for details. 

 

  

Quick Tutorial 

The following describe the relevant command line arguments for quick tutorial (--quick-tutorial or -QT):  

Description Argument long name Argument short name 

ODBC DSN  --meta-dsn <name> -SN <name> or /SN <name> 

ODBC DSN architecture  --meta-dsn-arch <32|64> -a <32|64> or /a <32|64> 

ODBC login name  --meta-user-name <name>  -SL <name> or /SL <name> 

ODBC password --meta-password <password>  -SP <password> or /SP 
<password>  

  

Note: 

Refer to Tutorial Data for details. 

 

  

  

Deploy Application 

The following describe the relevant command line arguments for deploy application (--deploy-app or -AL):  

Description Argument long name Argument short name 

Application ID file name --app-id-file-name <path name>  -AF <file name> or /AF <name> 

Application parameter file name --app-param-file-name <path name>  -PF <file name> or /PF <name> 

Log file name   --log-file-name <path name> -LF <path name> or /LF <path 
name> 

  

Note: 

Refer to Creating and Loading Applications from the Command Line for details. 

 

  

Windows Scheduler 

The following describe the relevant command line arguments for Windows scheduler (--win-scheduler or -WS):  

Description Argument long name Argument short name 

Scheduler name  --sched-name <name> -ID <name> or /ID <name> 

ODBC DSN  --meta-dsn <name> -SN <name> or /SN <name> 

ODBC DSN architecture  --meta-dsn-arch <32|64> -a <32|64> or /a <32|64> 

ODBC login name  --meta-user-name <name>  -SL <name> or /SL <name> 

ODBC password --meta-password <password>  -SP <password> or /SP 
<password>  
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Description Argument long name Argument short name 

Metadata schema/database  --meta-database <name>  -MS <name> or /MS <name> 

Service login name  --service-user-name <name>  -LN <name> or /LN <name> 

Internal scheduler name  --int-sched-name <name>  -IN <name> or /IN <name> 

Log level  --log-level <number> -LL <number> or /LL <name> 

Polling interval --poll-interval <number>  -PI <number> or /PI <name> 

Work directory   --work-dir <path name> -WD <path name> or /WD 
<path name> 

Log file name   --log-file-name <name> -WL <path name> or /WL <path 
name> 

TNS name  --tns-name <name>  -TN <name> or /TN <name> 

Service password  --service-password <password>  -LP <password> or /LP 
<password> 

Scheduler load type 
Notes: 

• If omitted, the scheduler 
load type defaults to 
ODBC.  

• The legacy option DL 
can be used to set only 
32 bit OCI load type. 

--sched-load-type 
<ODBC|OracleOCI|OracleOCI64> 

 -DL or /DL is equivalent to --
sched-load-type "OracleOCI" 

  

Note: 

Refer to Installing a Windows Scheduler for details.  

 

  

RED Client Command Line (med.exe) 

The RED Client command line interface enables you to execute commands to:  

• Generate documentation in batch 

• Create and deploy applications in batch 

• Perform start up tasks for a new metadata repository  

The following is a sample Windows Command Prompt that displays the help for RED Client (med.exe) arguments. 
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RED Client Command Line Arguments 

The following describe the command line arguments that can be used in RED Client (med.exe) arguments. 

Description Argument long name Argument short name 

Display the RED arguments. 
 
Note: No other arguments required. 

--help   -h or /h 

 Batch documentation create. 
 
 
Note: Must have other arguments, 
refer to Batch Documentation 
Creation in the RED User Guide. 

--create-docs -BD or /BD 

Batch deployment application 
create. 
  
 
Note: Must have other arguments, 
refer to Batch Deployment 
Application Creation in the RED 
User Guide. 

--create-deploy-app -BA or /BA 

First start with a new repository. 
  
 
Note: Must have other arguments, 
refer to New Metadata Repository 
Start up Task Creation in the RED 
User Guide.  

--new-meta-repo  -NEW or /NEW 
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Description Argument long name Argument short name 

Group name 
 
Note: All objects included, if group 
name is not specified.  

--group-name <name> -G or /G 

Multiple use: Output directory or 
Database schema. 

--output-dir <path name> or 
<db_schema> 

-D or /D  

Number of processes/ hops in the 
source diagrams. 

--num-source-hops <number> -S or /S 

Disable impact analysis  --no-impact-analysis -I- or /I- 

ODBC DSN   --meta-dsn <name> -O or /O 

ODBC user name --meta-user-name <name> -L or /L 

ODBC DSN architecture  --meta-dsn-arch <32|64> -A or /A 

ODBC username --meta-user-name <name> -U or /U 

 ODBC password   --meta-password <password>  -P or /P 

Connection name  --meta-dsn <name> -C or /C 

Metadata database 
 
Note: Only used in Teradata 

--meta-database <name> -M or /M 

Session user name  --red-user-name <name> -N or /N 

Application ID number  --app-number <name> -I or /I 

Application version number  --app-version <number> -V or /V 

Application ID file name  --app-file-name <path name> -AF or /AF 

Remove connections --remove-connections -RC or /RC 

Remove parameters --remove-parameters -RP or /RP 

Remove scheduler jobs  --remove-jobs -RJ or /RJ 

Group name  --group-name <name> -AG or /AG 

Project name --project-name <name> -AP or /AP 

All objects --deploy-all -ALL or /ALL 

  

The succeeding sections outline how the arguments are used. 

  

Batch Documentation Creation 

The following describe the relevant command line arguments for creating batch documentation (--create-docs or -
BD):  

Description Argument long name Argument short name 

ODBC DSN --meta-dsn <name> -C or /C 

ODBC DSN architecture  --meta-dsn-arch <32|64> -A or /A 

ODBC user name --meta-user-name <name>  -U or /U 

 ODBC password   --meta-password <password>  -P or /P 

Metadata database 
Note: Only used in Teradata 

--meta-database <name> -M or /M 

RED user name  --red-user-name <name> -N or /N 
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Description Argument long name Argument short name 

Group name 
Note: All objects included if group 
name is not specified.  

 --group-name <name> -G or /G 

Output directory --output-dir <path name> -D or /D 

Number of processes/ hops in the 
source diagrams 

--num-source-hops <number> -S or /S 

Disable impact analysis --no-impact-analysis -I- or /I- 

  

Note: 

Refer to the Batch Documentation Creation section of the RED User Guide for details. 

 

  

Batch Deployment Application Creation 

The following describe the relevant command line arguments for creating batch deployment application (--create-
deploy-app or -BA):  

Description Argument long name Argument short name 

Output directory --output-dir <path name> -D or /D 

ODBC DSN --meta-dsn <name> -C or /C 

ODBC DSN architecture  --meta-dsn-arch <32|64> -A or /A 

ODBC user name --meta-user-name <name>  -U or /U 

 ODBC password   --meta-password <password>  -P or /P 

Metadata database 
Note: Only used in Teradata 

--meta-database <name> -M or /M 

RED user name  --red-user-name <name> -N or /N 

 Application ID number   --app-number <name> -I or /I 

Application version number  --app-version <number> -V or /V 

Application ID file name 
(e.g. app_id_xxx.wst) 

--app-file-name <path name> -AF or /AF 

Remove connections --remove-connections -RC or /RC 

Remove parameters --remove-parameters -RP or /RP 

Remove scheduler jobs --remove-jobs -RJ or /RJ 

Group name --group-name <name>  -AG or /AG 

Project name --project-name <name> -AP or /AP 

All objects --deploy-all -ALL or /ALL 

  

Note: 

Refer to Creating and Loading Applications from the Command Line for details.  
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New Metadata Repository Start up Task Creation 

The following describe the relevant command line arguments for creating start up tasks for a new metadata 
repository (--new-meta-repo or -NEW):  

Description Argument long name Argument short name 

ODBC DSN --meta-dsn <name> -O or /O 

ODBC DSN architecture  --meta-dsn-arch <32|64> -A or /A 

ODBC user name --meta-user-name <name>  -L or /L 

Metadata database --meta-database <name> -D or /D 
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